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How to Use This Manual

Structure of the Manual
Before reading this manual, read the Operation Guide and User’s Manual to 
understand the basic operations.
This manual consists of the following three chapters, an appendix, and an index.
Chapter		  Title and description
1			   Overview and Basic Operations
			   Explains the basic operations for configuring the custom display.

2			   Advanced Settings of Screen and Component
			�   Explains the attribute of each component.

3			   Saving and Reading Screen Data
			   Explains the saving and reading of the configured custom display.

Appendix	 Gives an example of the construction of an actual custom display. 
Index			  The index is listed alphabetically.

Symbols Used in This Manual

		

Subheadings

Procedure

Explanation

Note Calls attention to information that is important for proper operation 
of the instrument.

Carry out the procedure according to the step numbers.
All procedures are written with inexperienced users in mind;
depending on the operation, not all steps need to be taken.

Explanation gives information such as limitations related the 
procedure.

This mark is used to indicate a reference to a related procedure 
or explanation.
Example : ►Section 4.1

Markings



iiiIM 04L41B01-04E

Revision History

Document name:		  DX1000/DX1000N/DX2000 Custom Display User’s Manual
Document number:		 IM 04L41B01-04E

Edition Revised Revisions, DX recorder series number
1st November, 2008 New, R3
2nd March, 2010 Added components, R4

Components added: �Group name, System icon, Memory bar, 
Time label, Batch group number,  
Batch name, and Modbus In. 

3rd December, 2010 Added attributes, R4 (firmware version 4.11)
Attributes added: �Background transparent of batch name 

component and decimal place of communication 
input component and modbus in component. 

Changed functions : �The batch name component display is 
updated every second.
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1.1	 Overview

Custom display is a function to allow you to configure any screen to use it as the operation 
screen. Custom display consists of the builder screen and execution screen, which actually 
displays a configured screen as the operation screen. Switching between the builder screen 
and execution screen enables you to configure a screen while checking the execution screen.

		

Builder screen Execution screen

RUN PNL soft key
Builder soft key
FUNC key

Builder Screen
Configure a screen.

		  Cursor

Soft key menu

Screen construction area

Status area

If the status area is set to No Display, 
the screen construction area becomes larger. 

Soft Key Menu on the Builder Screen
Soft key menu Description Reference
TOOL BOX Used to create components. Section 1.4

GRID Used to make grid settings on the builder screen. Section 1.3

MOVE Used to move the position of components. Section 1.5

RESIZE Used to change the size of components. Section 1.6

PROPERTY Used to set the attribution of components. Section 1.7, 
Chapter 2

PASTE Used to copy and paste components.
This is hidden before you copy components.

Section 1.8

COPY Used to copy components. Section 1.8

ORDER Used to set the arrangement (overlapping) of 
components.

Section 1.9

DEPEND Used to make the visibility of components dependent 
on other components.

Section 1.10

GR. CTRL Used to manage grouped components. Section 1.11

NO MENU Used to temporarily hide the soft key menu. Section 1.13

RUN PNL Used to execute and display a configured screen as a 
custom display.

Section 1.13

DELETE Used to delete specified components. Section 1.12

ALL DEL Used to delete all specified components on the builder 
screen.

Section 1.12

UPDATE Used to update a screen registered in external media 
(CF card).

Section 1.13

Chapter 1	 Overview and Basic Operations
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Execution Screen
Display a configured screen as an operation screen.
With the Runtime menu of  
screen attributes turned Off

With the Runtime menu of  
screen attributes turned On

		  	

	 For information on the Runtime menu of screen attributes, see section 2.1.
When you turn On the Runtime menu of the screen attributes in the builder screen, the 
Builder and MENU soft keys are displayed in the execution panel. 

	 See Section 2.1: These keys are not displayed in the factory default setting.
•	 On the execution screen, you can execute configured actions by selecting 

components with action functions (switch, push button, COMM IN, and Modbus IN) 
using the up and down arrow keys and pressing DISP/ENTER. The ESC key allows 
you to unselect components with action functions.

•	 The left and right arrow keys allow you to switch the group number for group control 
for components with the group attribute.

Screen Transition

		

Builder screen Execution screen
Press RUN PNL soft key to transit

Press FUNC > Builder soft key to transit

Select Screen menu by 
pressing DISP/ENTER 
to transit

Select Screen menu by 
pressing DISP/ENTER 
to transit

Operation screen

Screen
configuration

Trend, etc.

For the first screen configuration, select INTERNAL 1 to 3 from the submenu of the 
screen menu. INTERNAL 1 to INTERNAL 3 are the names of the custom display screens 
stored in the DX recorder’s internal memory. This screen name is displayed even when 
not building a screen.

	 For saving and reading screen data, see Chapter 3.

Precaution regarding the display processing time
Custom display screens that are created can take time to appear. If this is the case, 
saving of measured data and output of communication data will occur correctly, but 
please be aware of the following. 
•	 Key operations cannot be performed until display processing is finished. 
•	 If an event associated with an event action occurs, processing of the event can be 

delayed until the display processing is completed. 
•	 Web screen updating can be slower. 

1.1  Overview
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Operation Flow (operation guide)
This section briefly explains the operation to display the builder screen, then create 
components, and finally display the execution screen. Here, the creation of digital 
components is taken as an example.
Display the builder screen (see section 1.2)

1.	 Press DISP/ENTER and use any arrow keys to select the [CUSTOM DISPLAY].

2.	 Use any arrow keys to select one of the submenus, [INTERNAL 1] to [INTERNAL 
3], and press DISP/ENTER.

					   

The execution screen appears first.

3.	 Press FUNC to display the soft key menu, and press the Builder soft key.
The builder screen appears.

					   

Execution screen Builder screen 

Create Components (see section 1.4)
4.	 Press the TOOL BOX soft key and then press the DIGITAL soft key.

The digital component is selected.
					   

5.	 Use the arrow key to specify the size of a digital component, and press DISP/ENTER 
to confirm.
You may specify the size from the origin toward the lower right.

					   

Origin

Display the Execution Screen (see section 1.13)
6.	 Press the RUN PNL soft key.

The execution screen appears. To go back to the builder screen, perform Operation 3.

					   

Builder screen Execution screen 

Operation completed

1.1  Overview
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1.2	 Display the Builder Screen

Procedure
1.	 Press DISP/ENTER.

The screen menu appears.

2.	 Use the up and down arrow keys to select the CUSTOM DISPLAY, and press 
the right arrow key.
The submenu appears.

					   

3.	 Use the up and down arrow keys to select one of the submenus, [INTERNAL 1] 
to [INTERNAL 3], and press the DISP/ENTER.
The execution screen appears.

					   

4.	 Use the FUNC to display the Builder soft key on the function menu.
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The builder screen appears.

					   

Note
[Builder screen] on the function menu

•	 This might not be displayed depending on the user restriction setting.
•	 If key lock is activated, selecting this key will return an error.

Explanation
The submenu shows screen names registered in the internal memory and external 
storage media (CF card).

				  

(1)

(2)

• 	 Submenu (1) shows screen names of custom display registered in the internal 
memory. Up to 3 screens can be registered in the internal memory.

• 	 Submenu (2) shows screen names of custom display registered in external storage 
media (CF card). �Up to 25 screens can be registered in a CF card.

	 For saving and reading screen data, see Chapter 3.

Note
•	 You can change the order of the submenus by using the menu customization function  

(  IM04L41B01-01E, or IM04L42B01-01E). 
•	 When loading a custom display screen created in DXAdvanced R4 on a DXAdvanced R3 

instrument, components and attributes newly available in R4 are ignored.

1.2  Display the Builder Screen
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1.3	 Set Grid (Cursor Movement Interval)

Cursor moves at defined grid intervals. No grid appears on the screen.

Procedure
1.	 Press the GRID soft key.

The grid interval menu appears.

					   

2.	 Press the soft key for a grid interval to be set.
You can move the cursor at the defined grid intervals.

					   

Explanation
Range of Grid Setting
You can select the grid from 1, 5, 10, 20, and 50 dots.

Setting the upper left-hand corner of the builder screen as an origin, the grid is set at 
defined dot intervals.
The cursor stops at the right-hand edge and bottom edge on the builder screen even 
without a grid.

		

Origin

Immediately after changing the grid setting, the cursor may not be positioned on the grid. 
In this case, press one of the left or right arrow keys once and then press one of the up 
or down arrow keys to stop the cursor on the grid. (The same happens if you press the 
up or down arrow keys first and then the left or right arrow keys.

				  

Position right after the grid has been changed 

Cursor position when you press the
down arrow key after pressing the
right arrow key 
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1.4	 Create Components

	 For details of each component, see “Chapter 2.  Advanced Settings of Screen and Component.”

Procedure
1.	 Use the arrow key to move the cursor to the point where you want to create components.

You may move the cursor after creating components.

2.	 Press the TOOL BOX soft key.
The soft key menu for each component appears.

3.	 Press the soft key for components to be created.

4.	 Use the arrow key to manipulate the component size frame and determine the size.
You may change the size after creating components.
•	 You can manipulate the component size frame only toward the llower-right corner from the origin.

					   

You can adjust the component size 
by changing the grid option.

Component size frameOrigin

When you press the NO MENU 
soft key, the menu show at the 
bottom of the screen will be 
hidden, which allows you to 
see the drawing area of the 
component.

5.	 Press DISP/ENTER.
Components are created.

					   

Explanation
Number of Components Which Can be Created on One Screen
Limitations exist according to the component type. If you attempt to create components 
exceeding the number of components which can be created, an error message will 
appear to prevent you from creating components.
	 Error message: Cannot create object. The maximum allowed number was exceeded.
	 Number of components which can be created on one screen: See “ID number of 

components” on pages 1 to 7.
Arrangement Order
Components are placed to the front in the order of creation time. The last created 
component is placed in the foreground.



1-8 IM 04L41B01-04E

Component List
The order of the following parts is the order of soft keys displayed when creating DX 
recorder parts.

Digital Bar
You can set items to display 
on the vertical and
horizontal axes.

Trend
You can set items to display 
on the vertical and
horizontal axes.

Scale
You can set items to display on 
the vertical and horizontal axes.

Switch
You can select from nine 
different switch types.

Label
You can specify vertical or 
horizontal direction.

Tag
(If there is no tag No.)
You can specify vertical or 
horizontal direction.

Tag No./ Tag Comment
(If there is tag No.)
You can specify vertical or 
horizontal direction.

Simple digital

Simple bar
You can set items to display 
on the vertical and
horizontal axes.

Alarm mark
This component displays an 
alarm setting point on the 
simple bar graph.

Units
You can specify vertical or 
horizontal direction. 

Alarm indicator

Span lower limit/  
Span upper limit

Message list Alarm List Bitmap

Group name
You can specify vertical or 
horizontal direction. 

System icon
You can display information 
in the status area using 
icons. 

Memory bar
You can display the progress 
of memory sampling of 
display data or event data in 
a bar. 

Time label
You can specify vertical or 
horizontal direction. 

Batch group number
You can specify vertical or 
horizontal direction. 

Batch name
You can specify vertical or 
horizontal direction.

Line Rectangle

Circle Push button Comment box Comment block
You can specify vertical or 
horizontal direction.

COMM IN Modbus In

1.4  Create Components
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ID Number of Components
When a component is created, an ID number is assigned for identifying it. The ID number is 
assigned in the order of creation and varies depending on the component type as follows:

Component type Component name Update cycle ID number Number of components which 
can be created on one screen

Components for 
channel assignment

Digital 1 sec. 0 to 79 80
Bar 1 sec.
Tag No. None
Tag comment (Tag) None
Simple digital 1 sec.
Simple bar 1 sec.
Alarm mark 1 sec.
Unit None
Alarm indicator 1 sec.
Span L None
Span U None

Status display 
component

System icon
Memory bar
Time label
Batch group number
Batch name
Group name

1 sec.
1 sec.
1 sec.
None
None
None

Label components Label None
Components with 
action functions

Push button
Switch
COMM IN
Modbus In

None

1 sec.
1 sec.
1 sec.

Components for 
comment display

Comment box
Comment block

None
None

Components for list 
display

Alarm list
Message list

1 sec.
1 sec.

80 to 83 4

Components for trend 
display

Trend Display 
update rate

84 to 87 4

Scale components Scale Measurement 
interval

88 to 91 4

Diagram components Line None 92 to 131 40
Rectangle None
Circle None

Components for static 
image display

Bitmap None 132 to 133 2

Component Text String Display Restriction
If component text strings go outside the display area, the text strings out of the area are 
not displayed.

		
Not displayed 

1.4  Create Components
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Display When Components Overlap on the Execution Screen
Limitations (A, B, and C) apply when components overlap on the execution screen. If 
components with the same overlap restriction are overlapping, components placed under 
the front component (i.e., in the background) are not displayed.
Overlap restriction Component name (attribute conditions)
None Digital, bar, scale (kind: OFF), label, tag No., tag comment, simple 

digital, simple bar graph, alarm mark, units, alarm indicator, span 
lower limit, span upper limit, group name, system icon, memory bar, 
time label, batch group no., batch name, line, rectangle, circle, push 
button, switch, comment box, comment block, communication input, 
Modbus imput

A Scale (kind: ON)
Alarm list
Message list

B(*) Scale (kind: bitmap), bitmap
C Trend

*	 Overlap restriction B only shows the front component even on the builder screen.

For example, if two components with Overlap restriction A are overlapping on the builder 
screen, only the front component is displayed on the execution screen.

		
FrontBack

Overlapping of Components
As in the figure below, when components A and B are placed side-by-side on the same 
grid, their sides overlap by 1 dot in width.

		

GridComponent A Component B

1.4  Create Components
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1.5	 Move Components

Procedure
1.	 Use the arrow key to place the cursor on the component which you want to 

move.

2.	 Press the MOVE soft key.
The movement frame (the component frame becomes a dashed line: )  is displayed.

3.	 Use the arrow key to move the movement frame to the point where you want to 
place a component.

					   

4.	 Press DISP/ENTER.
The component moves to the specified point.

					   

Explanation
Setting the upper left-hand corner as an origin, components move on the grid.
Components do not go over the builder screen (configuration area). Therefore, even if 
you press the arrow key you may not be able to move the movement frame. In this case, 
making grid intervals smaller will enable you to move the movement frame.
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1.6	 Change the Component Size

Procedure
1.	 Use the arrow key to place the cursor on the component whose size you want to 

change.

2.	 Press the RESIZE soft key.
The component size frame (the component frame becomes a dashed line: ) is displayed.

3.	 Use the arrow key to manipulate the component size frame and determine the 
size.

					   

4.	 Press DISP/ENTER.
The component size is changed.

					   

Explanation
The upper left of a component is fixed as origin. The size changes rightward and 
downward.

					     Origin

Resized frame
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1.7	 Display the Attribute Setting Dialog of 
Components 

	 For details of each component, see “hapter 2. Advanced Settings of Screen and 
Component.”

Procedure
1.	 Use the arrow key to place the cursor on a component.

					   

2.	 Press the PROPERTY soft key.
The simple attribute setting dialog appears.

					   

3.	 Use the arrow key to select the Details button and press DISP/ENTER.
The detail attribute setting dialog appears. Using the left and right arrow keys, you can page 
a dialog with more than one page.

					       

4.	 Use the arrow key to select the Sync act button and press DISP/ENTER.
The synchronize action attribute setting dialog appears.

					   

Explanation
The attribute setting dialog box consists of the following three dialog boxes:
Dialog box Description
Simple attribute setting You can set only main attributes.
Detail attribute setting You can set all attributes.
Synchronize action 
attribute setting

You can set the visibility of components which are synchronized 
with the alarm or switch.
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1.8	 Copy Components (Copy and Paste)

Procedure
1.	 Use the arrow key to place the cursor on the component which you want to copy.

2.	 Press the COPY soft key.

					   

3.	 Use the arrow key to move the cursor to the point where you want to place a 
component.

4.	 Press the PASTE soft key.
Copied components are pasted.

					   

Explanation
All contents to be copied are attribute information excluding the ID, depend ID, group 
control, and Gr.ctrl order. The ID number is assigned in the order of component creation.
If you attempt to create components exceeding the number of components which can be 
created, you cannot copy any component.

If you press the PASTE soft key at the cursor position shown in the lower left figure, a 
component is placed as the lower right figure shows. A component is placed so that it 
does not go over the screen.
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1.9	 Change the Component Arrangement Order

You can change the arrangement of a specified component to the front or back.

Procedure
1.	 Use the arrow key to place the cursor on the component whose arrangement 

order you want to change.

					   

2.	 Press the ORDER soft key.
The soft key menu (ToFRONT, ToBACK, ToTOP, ToBOTTOM, BACK) appears.

3.	 Press the relevant soft key.
Components are arranged in accordance with the selected soft key.

					   

Explanation
Components are placed to the front in the order of creation time. The last created 
component is placed on top.
Soft Key Menu
	 ToFRONT: Move to the front by one component.
	 ToBACK: Move to the back by one component.
	 ToTOP: Move to the top.
	 ToBOTTOM: Move to the bottom.
	 BACK: Cancel the change to the arrangement order and go back to the original 

screen.
	 (The BACK soft key does not revert any change in component arrangement to the 

original arrangement order.)
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1.10	 Have the Visibility Attribute of a Component 
Depend on Another Component

This section explains the operation using the soft key.
	 It is also possible to set dependency based on individual components attributes. See 
Chapter 2.

Procedure
1.	 Use the arrow key to place the cursor on the component which you want to 

subordinate (A).

2.	 Press the DEPEND soft key.
The soft key menu appears.

					   

(A)(A) (B)(B)

3.	 Press the DEPEND soft key.

					   

4.	 Use the arrow key to place the cursor on the component which is depended on (B).

					   

(A)(A) (B)(B)

5.	 Press DISP/ENTER.
The visibility attribute of the component (A) depends on that of the component (B).

To Release Dependency:
1.	 Place the cursor on the depending component and then press the DEPEND soft 

key.

2.	 Press the INDEPEND soft key.
Dependency relationship is released.

To Change the Component Which is Depended on:
1.	 Place the cursor on the depending component and then press the DEPEND soft 

key.
The following dialog appears:

					   

2.	 Select [OK].

3.	 Use the arrow key to place the cursor on the component which you want to depend on.

4.	 Press DISP/ENTER.
The component which is depended on is changed.
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Explanation
As shown in the below figure, if where the visibility attribute of component (A) is 
depending on that of component (B), when you set the visibility attribute of component (B) 
to Off, the visibility attribute of component (A) will be turned off as well. In this case, only 
component (C) will be displayed on the execution screen.

		

Builder screen Execution screen 

(A)(A) (B)(B)

(C)(C)

Depending 

The following section provides explanations by referring to a component depending 
on another component as the “depending component” and a component which is 
depended on as the “depended component”.
If a depended component is subordinated to another component:
	 If a depended component is subordinated to another component, the original 

dependency relationship is contained in the newly created depending component. In 
the case of the figure below, components A and B depend on component C.

		
Component A 

Depending
Component B Component C 

Depending

If a depended component is deleted:
	 If a depended component is deleted, its depending component loses the dependency 

relationship. In the case of the figure below, if component B is deleted, no dependency 
relationship exists between component C and A.

		

No dependency 
Delete

Component A Component B Component C 
DependingDepending

If an attempt is made to subordinate a depended component to a 
depending component:
	 Any depended component cannot depend on its depending component. In the case of 

the figure below, component C cannot depend on component A or B. (No dependency 
relationship can be circulated.)

		

Component A Component B Component C 
Depending Depending

Depending is impossible Depending is impossible 

1.10  Have the Visibility Attribute of a Component Depend on Another Component
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1.11	 Register Components in the GR. CTRL

It is a function that switches the display of components created by each display group. 
In the Gr. Ctrl dialog, you will be able to list or edit the settings configured by attribute of 
each component. This section explains the operation using the soft key menu.
	 You will configure the group control based on individual component’s attributes. See 
Chapter 2 and Appendix 1.

Procedure
1.	 Pres the Gr. Ctrl soft key.

2.	 Press the soft key for the Grp control number to be registered.
					   

The Grp control dialog appears.

3.	 Set the batch group number*, group number, and switching groups using the soft 
key.
*	 The batch group number is displayed when the Multi batch (additional 
specifications/ BT2) is valid.

					   

When the Multi batch /BT2 is valid

4.	 Use the right arrow key to display the second page.

5.	 Enter the ID number for components to be managed as a group.

					   

6.	 Use the arrow key to select [OK] and press DISP/ENTER.

Explanation
If components are managed as a group, you can switch channels to be displayed by 
switching groups on the execution screen with the left and right arrow keys.
•	 You can switch the group number of components which contain the group number as 

an attribute (trend and scale).
•	 You can switch the channel number of components which only contain the channel 

attribute (channel number).
Batch group no
	 Setting range: From 1 to the number of Multi batches defined in the basic setting
Group no
	 Setting range:
	 If the multiple batch is Off, DX1000 is between 1 and 10 and DX2000 is between 1 and 36. 

If the multiple batch is On, DX1000 is between 1 and 6 and DX2000 is between 1 and 12.
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Switching groups
	 On: �When you press the left or right key in the execution panel, the group number 

display switches. 
	 Off: �If you press the left or right key in the execution panel, the group number display 

does not switch. 

Order
	 It is an order of channel configured for each display group. For example, if “003, 004, 

005” is configured for display group 1, the order 1 of group number 1 is CH3, the order 
2 corresponds to CH4, and the order 3 corresponds to CH5 respectively.

	 Setting range: 1 to 6 for DX1000 and 1 to 10 for DX2000

Here is the explanation using the display group setting and the dialog below as an 
example.
A channel configured at the first channel in the display group 1 will be assigned to the ID 
registered in the order of (0, 6, 7, 8, 9), which is registered at the order 1 of group number 1.
You can also switch groups using the left and right arrow keys on the execution screen. 
(You can switch channels of components registered at the order 1, which is in the order 
of “1”, “7”, “3”, and “101”.)

	 Display Group Setting Example
Group number

Order 1 2 3 4
1 1 7 3 101
2 2 8 5 102
3 3 9 8 No setting
4 4 10 1 No setting
5 5 11 4 No setting
6 6 12 7 No setting

	 In the bold frame, you will see channels assigned for each display group.
	 If “no setting” is assigned to a component, only the frame is displayed. For example, 

only the frame will be displayed for the component (ID) registered at the order 3 of 
group number 4. 

			    

Channel 1 is assigned. 

Channel 2 is assigned. 

Channel 3 is assigned. 

Channel 4 is assigned. 

Channel 5 is assigned. 

Channel 6 is assigned. 

1.11  Register Components in the GR. CTRL
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Example for Group Control Settings
In the screen showing a bar graph of the measured values from 2 channels, the 
measured values displayed depend on the display groups as follows: display group 1 = 
ch 1 and ch 2; display group 2 = ch 3 and ch 4; display group 3 = ch 5 and ch 6; display 
group 4 = ch 7 and ch 8.

		

Tag (ID: 0)
Simple digital (ID: 2)

Span upper limit (ID: 3)
Simple bar (ID: 4)

Span lower limit (ID: 5)

Tag (ID: 1)
Simple digital (ID: 6)
Span upper limit (ID: 7)
Simple bar (ID: 8)

Span lower limit (ID: 9)

Display group 1 shows: Channel 001 Channel 002
Display group 2 shows: Channel 003 Channel 004
Display group 3 shows: Channel 005 Channel 006
Display group 4 shows: Channel 007 Channel 008

•	 Setup Screen and Setup Items
	 Display Group Settings
	 Press MENU (to switch to setting mode), and select the Menu tab > Group set, Trip 

line

			 

Group number CH set
1 001.002
2 003.004
3 005.006
4 007.008
Group 5 and group 6 are set to Off.

1.11  Register Components in the GR. CTRL
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Group Control Settings
Group control is set up in the attribute dialog boxes of each individual component. 
Tag (ID:0) attribute setting dialog box

Uses GR. CRTL 1.
Because this component is associated 
with the first registered channel of each display group, set 1.

The settings can be displayed in the GR. CTRL. dialog box. They can also be edited.

These are the IDs of the components associated with the channel registered 
first in each display group. 
These are the IDs of the components associated with the channel registered 
second in each display group. 
Order means the order of channel registrations in the display group settings. 
In this example, channels 001, 003, 005, and 007 are registered to order 1.

This is the group number displayed when moving to the execution screen. 
When switching the display group in the execution screen, this number also 
changes to the displayed group number.

<Operation>
By repeatedly pressing the right arrow key, the screen changes in the order: display 
group 1 -> display group 2 -> display group 3 -> display group 4 -> display group 1… and 
so on. Pressing the left arrow key changes the screens in reverse order. Display groups 
turned Off in the group settings do not appear among the switched screens.

1.11  Register Components in the GR. CTRL
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1.12	 Delete Components

To delete components, you delete either a specified component (one component) or all 
components on the screen.

Procedure
To Delete a Specified Component:

1.	 Use the arrow key to place the cursor on the component which you want to 
delete.

					   

2.	 Press the DELETE soft key.
The confirmation dialog appears.

					     Kind and ID number of the 

component to be deleted

3.	 Use the arrow key to select [OK] and press DISP/ENTER.
The specified component is deleted.

To Delete All Components:

1.	 Press the Delete all soft key.
The confirmation dialog appears.

					   

2.	 Use the arrow key to select [OK] and press DISP/ENTER.
All components on the builder screen are deleted.
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1.13	 Other Operations

To Display the Execution Screen:
	 Press the RUN PNL soft key.

The execution screen appears.

						    

Execution screen Builder screen 

To Go Back to the Builder Screen:
	 Press FUNC, and press the Builder soft key.

If the screen attribute runtime menu is on, the soft key menu is displayed on the lower left 
hand on the execution screen. Then, press the Builder soft key.

						    

If the screen attribute runtime menu is ON 

To Hide the Menu:
	 Press the NO MENU soft key.

The soft key menu is hidden and the bottom end of the screen becomes visible.

						    

	 To show the soft key menu, press ESC.
If the soft key menu is hidden, it is disabled.
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To Update an Edited Screen:
When editing the internal memory data displayed on the custom screen submenu, the 
screen data is saved in the internal memory. But if editing data in an external storage 
medium, if you attempt to move to another screen, a message appears. 

	 For an explanation of data from internal and external storage media, see section 1.2. 

					   

After editing the [Create], or [EXTERNAL 1] through [EXTERNAL 25] screens, be sure to 
update the screen. If you do not update the screen, the edited data will be lost. 

	 Press the Update soft key after editing a screen.
If you try to go to another screen without updating, the above caution dialog appears. If you 
want to update the screen, select “No” to go back to the builder screen being edited.

Operations which show the caution dialog
Operations Description
DISP/ENTER key Displays the screen menu
START key Memory start action/ start screen display
MENU key Displays the setting menu
FUNC key > system information soft key Displays the system information screen
FUNC key > network information soft key Displays the network information screen
FUNC key > text field soft key Displays the text field screen

Note
•	 The screen can be changed by using the communication commands or by using screen 

change with the event action/start. However, screen data being edited will be lost.
•	 If any USB memory is inserted while a screen is being edited in external storage media (CF 

card), the USB memory operation selection screen does not appear.
•	 While data is being edited on the builder screen, the following actions do not work:

•	 Automatic screen recovery
•	 Event action favorite key action
•	 FAVORITE key (shows error E157)

1.13  Other Operations



2-1IM 04L41B01-04E

A
dvanced Settings of Screen and C

om
ponent

1

2

3

App

Index

2.1	 Screen Attribute

This section shows you how to configure attributes associated with screen name, base 
color and runtime menu.

Precedure
1.	 On the builder screen, place your cursor in an area where there is no component.

2.	 Press the PROPERTY soft key.
Screen attribute setting dialog appears.

					   

3.	  Configure each attribute.

Explanation
The below table shows each setting item and description.

Attribute Description Default value
Screen name This attribute will be displayed in the status display on the 

custom display screen. It will be displayed in the submenu of 
the screen menu as well.
You can enter up to 16 one-byte characters.

Base color You can configure the background color of the screen. 
Display components without any background color will be 
filled with the color configured here.
The colors available are [Lightgray], [Lightblue], [L.orange], 
[Aquamarin], [Darkgray], [Darkblue], [Darkgreen], [White], and 
[Black]

Lightgray

Runtime menu You can choose to show or hide the soft key menu on the 
execution screen by setting [On] or [Off] at this field.

Off

Soft key menu displayed on the execution screen
[SET PNL] Switch to [Builder screen].
[NO MENU] Temporarily hide the soft key menu. 

Pressing the [ESC] key will show the soft 
key menu again.

Status area Sets [On] or [Off] to indicate whether or not the status area 
is displayed. When the status area is set to [Off], the screen 
construction area becomes larger. See the figure below.

On

When the status area is [On] When the status area is [Off]

DX1000 (0,24)
DX2000 (0,40)

DX1000 (319,239)
DX2000 (639,479)

(0,0)

(0,0)

Screen
construction
area

Chapter 2	 Advanced Settings of Screen and Component
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2.2	 Common Attributes of Components

This section explains the common attributes used for multiple components.

Attribute Settings
To fix the setting value, select [OK] in the attribute setting dialog after you have changed 
the settings of component attributes.
Selection
	 You will see a selection [SET] in the attribute settings. This indicates a value 

configured at the setting menu of this device.
Font
	 The following character types are available.

Font
(character size)

Description

Font 5

English one-byte characters.
ISO8859-1 (Some symbols are not available.)

Font 6
Font 8
Font 12
Font 16
Font 32

Batch Group Number (Additional Specification/BT2: Multi batch Functions Only)
This is an attribute you will be able to configure with trend components, scale components, 
message list components, alarm list components, Multi batch number components, 
batch name components and GR CTRL 1 to 4. You can set this attribute when the Multi 
batch function is turned on. The batch group number configured will be validated when 
you display a custom display screen in the batch overview mode. When you display a 
custom display screen in the batch single mode, the batch group number configured at 
the attribute will be ignored. In this case, the effective batch group number is that of the 
individual batch mode.

Frame
Set the frame of components. You can select [None], [Black], [White], [Raised], or 
[Sunken].

			 
None Black White Raised Sunken

[None]: no frame; [Black]: solid line black frame; [White]: solid line white frame; [Raised]: 
convex shaped frame; [Sunken]: concave shaped frame

Depend ID
Set the component ID on which this component is dependent. You can set this field as 
[None] or select an ID number of the components on the screen. For example, if you 
have the following components whose IDs are 0 to 3 on the [Builder screen], the IDs you 
will be able to configure are shown in the below table.

				  

ID
0
1
2
3

None
None
None
None

1
2
3
0

Configurable ID 
2
3

1

3

2

0ID

Depend on 1 

1 2 3

Depend on 2 

	� You can also configure dependent IDs using the soft key. See section 1.10 for more 
information about dependent IDs.
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Visible
You can choose to show or hide the components on the execution screen.
	 On: Show components on the execution screen and builder screen.
	 Off: �Hide components on the execution screen. Components will be visible on the 

builder screen.
You will not be able to change this setting if a component is depending on other 
components.

Group control
You can configure settings of display group control status.
Setting range
	 You can select [None], [GR. CTRL 1], [GR. CTRL 2], [GR. CTRL 3], or [GR. CTRL4].
	 You can also configure group control settings using the soft key. See section 1.11 or 
appendix 1 for more information about group control.

Gr.Ctrl order (Group control order)
You can configure the group control order. This setting is available when you set anything 
except [None] for the group control.
Setting range
	 DX1000 = 1 to 6, DX2000 = 1 to 10
	 You can also configure group control settings using the soft key. See section 1.11 for 
more information about group control.

Sync act (Synchronize action)
You can change the show/hide settings of components on the execution screen by 
synchronizing On/Off settings of alarm or internal switch. You can also enlarge the 
display of trend components and scale components to an arbitrary span by configuring 
the 2nd span.
Depend ID configured will invalidate the visible setting at the synchro attribute field.

		

Synchro target: Alarm Synchro target: Switch 

Attribute Description Default value
Synchro attribute Configure the attribute you want to synchronize.

You can select None, Visible, or 2nd span. 2nd span is 
available for trend components and scale components 
only.

None

Value (switch On) Configure the synchro attribute value when the synchro 
target (alarm or switch) is set to On. Select On or Off.

On

Synchro target Configure the target you want to synchronize.
Select alarm or switch.

Alarm

Channel no
or
Switch no

Configure channel number or internal switch number 
you want to synchronize. If the synchro target is an 
alarm, enter a channel number. If it is a switch, select 
an internal switch number.

1

Alarm level Configure the alarm level you want to synchronize.
Select any or all of the following setting range: 1, 2, 3, 4.

1

2.2  Common Attributes of Components
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2nd span
This is the attribute available with trend components and scale components only. You 
can enlarge the display of trend and scale by synchronizing the On/Off settings of alarm 
or internal switch. To validate the 2nd span, configure [2nd span] at the synchro attribute 
field. Scale and trend shown in the below figure are an example of displaying the 2nd 
span when the alarm is set to On.
(Example of settings)

• 	 2nd span: On; 2nd span Lower: 85.0%, 2nd span Upper: 100.0%
• 	 Synchro attribute: 2nd span; Value (switch On): On; Synchro target: alarm, 

Channel no: 1; Alarm level: 1

				  

Alarm set 

2nd span 

If a measured value exceeds the alarm set,
screen shows the enlarged image 
of this span as the 2nd span.

Configured span 

Restrictions on channel assignments
With the Math (/M1) and PROFIBUS-DP (/CP1) options, PROFIBUS-DP always uses the 
communication input channels in the table below. The channels in the table below cannot 
be assigned in a custom display. 

Channels used with the /M1 and /CP1 option
Type Communication input channels used
DX1000 C01 to C24 (all)
DX2000 C01 to C32

2.2  Common Attributes of Components
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2.3	 Attributes of Digital Components

These components are associated with displaying digital values. You can display digital 
value, tag (tag no., tag comment, or channel no.), unit, and alarm display mark.
Component type
(See Section 1.4.)

Channel assignment Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec.

Name of Each Component

		

Unit

Alarm display mark 

Digital value 

Tag No. / Tag (Tag comment) / Channel No. 

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
0 to 79

Channel no Set the channel number to be assigned.
You can configure this field when the group control is 
set to [None].

1

Digital font Set the character size of digital value.
You can select [Font 5], [Font 6], [Font 8], [Font 12], 
[Font 16], or [Font 32].

Font 8(DX1000)
Font 12(DX2000)

Channel font Set the character size of tag no., tag comment, and 
channel no.
You can select [Font 5], [Font 6], [Font 8], [Font 12], or 
[Font 16].

Font 6(DX1000)
Font 8(DX2000)

Unit font Set the character size of unit font.
You can select [Font 5], [Font 6], [Font 8], [Font 12], or 
[Font 16]. Note that this field will not be available when 
[Unit display] field is set to [Off].

Font 6(DX1000)
Font 8(DX2000)

2 Line display You can choose to display the character strings for 
channel font in 2 lines by setting [On] or [Off].

Off

Alarm display You can choose to show or hide the alarm display mark 
by setting [On] or [Off] at this field. The alarm display 
mark corresponds to level 1, level 2, level 3, and level 
4 respectively from the top. When alarm is set to [Off], 
it is displayed in lime. When alarm is [On], it will be 
displayed in a color configured for each level (red, 
orange, yellow, or pink).

On

Continued on next page
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Attribute Description Default value
Unit display You can choose to show or hide the unit display by 

setting [On] or [Off].
On

Frame Set the frame of a component.
See Section 2.2.

Raised

Depend ID Set the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible You can choose to show or hide this component by 
setting [On] or [Off].

See Section 2.2.

On

Group control Set the control status of group displayed.
See Section 1.11 and Section 2.2.

None

Gr.Ctrl order Set the control order of group displayed.
See Section 1.11 and Section 2.2.

1

Sync act See Section 2.2.

2.3  Attributes of Digital Components
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2.4	 Attributes of Bar Graph Components

These components are associated with displaying a bar graph. You can display tag no., 
tag comment, channel no., span, unit, alarm display mark, and alarm set-point mark.
Component type
(See Section 1.4.)

Components for 
channel assignment

Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec.

Name of Each Component

		

Direction: Vertical 

Direction: Horizontal 

Digital value (only vertical) 
Unit (only vertical) 

Alarm set-point mark 

Span value 

Alarm display mark (only vertical) 

Tag comment (only vertical) (Tag No.: On) 

Tag / Channel No. (only vertical) (Tag No.: Off) 
Tag No. / Channel No. (only vertical) (Tag No.: On) 

Attribute Setting Dialog
When Tag No. is set to On, the following attribute setting dialogs appear.

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
0 to 79

Channel no Set the channel number to be assigned.
You can configure this field when the group control is 
set to [None].

1

Channel font Set the character size of Tag No., Tag, or Channel No. 
When the Tag No. is set to On, it shows the Tag No. or 
Channel No. When Tag No. is set to Off, it shows the 
Tag or Channel No.
You can select [Font 5], [Font 6], [Font 8], [Font 12], or 
[Font 16].
Note that this field will not be available when the 
direction is set to [Horizon].

Font 6(DX1000)
Font 8(DX2000)

Continued on next page
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Attribute Description Default value
Tag font
(Displayed only 
when Tag No. is 
set to On.)

Set the character size of tag comment.
(Available font types are same as those for channel font.)
Note that this field will not be available when the 
direction is set to [Horizon].

Font 6

Digital font Set the character size of digital value. You can select 
[Font 5], [Font 6], [Font 8], [Font 12], [Font 16], or [Font 
32]. Note that this field will not be available when the 
direction is set to [Horizon].

Font 6(DX1000)
Font 8(DX2000)

Unit font Set the character size of unit font.
(Available font types are same as those for channel font.)
Note that this field will not be available when the unit 
display is set to [Off] or the direction is set to [Horizon].

Font 5

Span font Set the character size of span value.
(Available font types are same as those for channel font.)
Note that this field will not be available when [Span 
display] field is set to [Off].

Font 5

Bar color Set the color of a bar. You can select either [CHANNEL] 
or [Green]. If you select [Green] at this setting, the bar 
will be displayed in a color of the alarm when the alarm 
goes off.

CHANNEL 

Base position Set the base position of a bar graph. You can select 
[SET], [Normal], [Center], [Lower], or [Upper].

[SET]

Direction Set the direction of a bar graph. You can select either 
[Vertical] or [Horizon]. The default value will depend on 
the aspect ratio of component size drawn.

Depend on the 
aspect ratio of 
component size
Length ≥ �Width: 

Vertical
Length < �Width: 

Horizon
Alarm display You can choose to show or hide the alarm display 

mark by setting [On] or [Off] at this field. From left, it is 
level 1, 2, 3, and 4 respectively. When alarm is set to 
[Off], it is displayed in lime. When alarm is [On], it will 
be displayed in a color configured for each level (red, 
orange, yellow, or pink).
Note that this field will not be available when the 
direction is set to [Horizon].

On

Alarm mark 
display

You can choose to show or hide the alarm set-point 
mark by setting [On] or [Off] at this field.

On

Digital display You can choose to show or hide the digital value by 
setting [On] or [Off].

On

Unit display You can choose to show or hide the unit display by 
setting [On] or [Off].

On

Span display You can choose to show or hide the span display by 
setting [On] or [Off].

On

2 Line display You can choose to display the tag (tag comment) in 
two lines by setting [On] or [Off].
(The character strings for channel font will be displayed 
in two lines. When the Tag No. is set to On, the 
character strings for tag font will be displayed in two 
lines.)

Off

Frame Set the frame of a component.
See page 2-2.

Raised

Depend ID Set the ID number of the component on which this 
component is dependent. See Section 2.2.

None

Visible You can choose to show or hide this component by 
setting [On] or [Off]. See Section 2.2.

On

Group control Set the control status of group displayed.
See Section 1.11 and Section 2.2.

None

Gr.Ctrl order Set the control order of group displayed.
See Section 1.11 and Section 2.2

1

Sync act See Section 2.2

2.4  Attributes of Bar Graph Components
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2.5	 Attributes of Trend Components

These components are associated with displaying a trend. You can select either [Vertical] 
or [Horizon] for the wave direction.
Component type
(See Section 1.4.)

Trend display Overlap restriction
(See Section 1.4.)

C Update 
cycle

Display 
update 
rate

Name of Each Component

		

Message mark

GRID time

Direction: Horizontal Direction: Vertical

Time interval: EveryGridTime interval: Alternate

Margin OnMargin Off

Margin

Attribute Setting Dialog

		

(*)

* Batch group no. will be displayed 
   only when Multi batch (additional  
   specifcations  /BT2) is valid.
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List of Attributes
Attribute Description Default value
ID Number automatically assigned for component identification. 84 to 87
Batch group no 
 
 
only with additional 
spec. /BT2

Set the batch group number. The batch number needs to be within 
the range from [1] to number of Multi batch configured at the basic 
settings.  
The batch group number will be displayed only when Multi batch is 
valid.

1

Group no Set the group number.
Multi batch Off
You can select a number from [1] to [10] for DX1000, [1] to [36] for 
DX2000.
Multi batch On
You can select a number from [1] to [6] for DX1000, [1] to [12] for 
DX2000.

1

Direction Set the direction of trend display. You can select [SET], [Horizon], or 
[Vertical].

SET

Compress ratio Set the ratio of rendering 1 dot data.
You can select [1], [2], [4], [5], [6], [7], or [8].

1

Wave area Set the ratio used for displaying a wave to the width of temporal axis 
direction as 100%.
You can select [100], [90], [80], [70], [60], or [50].

100

Margin Sets whether or not to display a margin on both sides in the direction 
of the span. 
[On]: �Margin of 3% of component width is added in the direction of 

the span
[Off]: The margin is not displayed

Off

Change group Sets whether or not to switch the group display in the execution 
panel when the left/right keys are pressed. 
[On]: Display switched    [Off]: Display not switched

On

Message mark 
size

Set the size of message mark to be displayed. You can select either 
[Small] or [Large]. Note that this field will not be available when 
[Message display] field is set to [Off].

Large

Time/div font Set the character size of Time/div display. You can select either [Font 
6] or [Font 8]. Note that this field will not be available when Time/div 
display is set to [Off].

Font 6(DX1000)
Font 8(DX2000)

Time font Set the character size of GRID time display. You can select either 
[Font 5] or [Font 6]. Note that this field will not be available when time 
display is set to [Off].

Font 5

Time interval Sets the interval for displaying the time. It cannot be set when [Time 
display] is [Off].
[EveryGrid]: Displays in all time grids
[Alternate]: Displays in every other time grid

Alternate

2nd span Sets [On] or [Off] to indicate whether the 2nd span is Valid or Invalid.
See section 2.2

Off

2nd span     Lower Enter a value between 0% for the lower limit and 90% for the upper 
limit, with the difference between the 2 spans being 10% or greater.

See section 2.2

0

2nd span     Upper Enter a value between 10% for the lower limit and 100% for the 
upper limit, with the difference between the 2 spans being 10% or 
greater. 

See section 2.2

100

Message display You can choose to show or hide the message mark by setting [On] 
or [Off].

On

Time/div display You can choose to hide or show the Time/div display by setting [On] 
or [Off].

On

Time display Sets [On] or [Off] to indicate whether or not the grid time is displayed. On
Scale grid display Sets [On] or [Off] to indicate whether or not the scale grid is 

displayed. When [Time grid display] is [Off], the scale grid is 
automatically set to [Off], and cannot be set. 

On

Continued on next page

2.5  Attributes of Trend Components
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Attribute Description Default value
Time grid display Sets [On] or [Off] to indicate whether or not the time is displayed. 

When set to [Off], the [Time display] and [Time font] items cannot be 
set. 

On

Depend ID Set the ID number of the component on which this component is 
dependent.

See Section 2.2.

None

Visible You can choose to show or hide this component by setting [On] or 
[Off].

See Section 2.2.

On

Sync act See Section 2.2.

Note
•	 Depending on the display method, it may take time until the trend components in created 

custom display screens are displayed. To reduce the time, do the following. 
•	 If all channel display is turned On, turn it Off. 
•	 If displayed data is compressed along the time axis, lower the compress ratio or reduce 

the number of trend components. 
•	 Arrange push button, communication input, and switch components so that they do not 

overlap with trend components. If these components overlap with trend components, 
cursor movement can be slowed when selecting those components in the execution 
screen. 

•	 If the compress ratio of a trend component is set to 2 or higher, the trend display 
phenomenon below can occur. This results from the limited capacity of the internal memory, 
and does not indicate a malfunction. The data is written to the internal memory. 
Phenomenon: �When switching to the screen containing the trend display, old waveforms are 

erased and waveforms are displayed only part way through the data. 

2.5  Attributes of Trend Components
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2.6	 Attributes of Scale Components

These components are associated with displaying a scale. You can set vertical and 
horizontal direction.
Component type
(See Section 1.4.)

Scale Overlap restriction
(See Section 1.4.)

None: Type Off
A: Type On
B: Type Bitmap

Update 
cycle

Measurement 
interval

Component name and indicator type

		

Direction: 
Horizontal
Type: On

Direction: 
Vertical
Type: Off

Current position 
Scale value

Unit
Scale
(Type: On)

Direction: 
Vertical
Type: On

Indicator type

Micro
Normal

Small
Balanced

No scale margin

With scale margin

Margin

A mark appears if the scales overlap. 

The current position mark will be displayed on the execution screen only.

Attribute Setting Dialog

		
If you select here, the read destination 
directory of the bitmap appears.

(*)

* Batch group no. will be displayed only when Multi batch 
   (addtional specifications /BT2) is valid.
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List of Attributes
Attribute Description Default value
ID Number automatically assigned for component identification. 88 to 91
Batch group no 
 
 
only with additional 
spec. /BT2

Set the batch group number. The batch number needs to 
be between [1] and number of Multi batch configured at the 
basic settings.
The batch group number will be displayed only when Multi 
batch is valid.

1

Group no Set the group number.
Multi batch Off
You can select a number from [1] to [10] for DX1000, and [1] 
to [36] for DX2000.
Multi batch On
You can select a number from [1] to [6] for DX1000, and [1] 
to [12] for DX2000.

1

Kind Set the scale kind. 
[Off]: The value is not displayed. 
[On]: �Scale values will be displayed by the number of 

partitions configured, at previously defined intervals. 
[Bitmap]: �Use a bitmap image for the scale. If files specified 

under [Bmp filename] cannot be loaded, the scale 
the scale is displayed with the kind set to Off. 

On

Trend direction Set the direction of a wave. You can select [SET], [Horizon], 
or [Vertical].

SET

Form Set the size of SCALE. You can select either [Small] or 
[Large].

Small

Bmp filename Enter the name of a bitmap file saved on an external 
storage medium (CF card).
The read destination is the directory used when the screen 
was loaded.

Bitmap.bmp

Indicator Set how the current value is displayed.
You can select [SET], [Mark], or [Bar].
Note that this field will not be available when the type is set 
to [Off].

SET

Indicator type Set the indicator format to [Normal], [Micro], [Small], or 
[Balanced]. 
�See “Parts of the component and indicator types” on page 
2-12. 

Normal

Digit Set the number of digits for the value displayed at the scale.
You can select [SET], [Normal], or [Fine].
You can set this field only when the Kind is set to [On].

SET

Margin Sets whether or not to display a margin on both sides in the 
direction of the span. 
[On]: �Display a margin of 3% of component width (or height) 

in the direction of the scale
[Off]: Margin not displayed

Off

Change group Sets whether or not to switch the group display in the 
execution panel when the left/right keys are pressed. 
[On]: Display switched    [Off]: Display not switched

On

Alarm mark 
display

Set how the alarm set-point mark is displayed.
You can select [On], [Off], or [SET].

SET

Alarm mark Set the type of alarm set-point mark.
You can select [Alarm], [Fixed], or [SET].

SET

Unit Selects whether or not to display the units. 
[On]: Units displayed     [Off]: Units not displayed

On

2nd span You can choose to validate or invalidate the 2nd span by 
setting [On] or [Off].

See Section 2.2.

Off

2nd span Lower Enter a value between 0.0% for the lower limit and 100.0% 
for the upper limit. In this case, the difference between the 
two spans needs to be 10.0% or greater.

See Section 2.2

0.0

Continued on next page

2.6  Attributes of Scale Components
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Attribute Description Default value
2nd span Upper Enter a value between 0.0% for the lower limit and 100.0% 

for the upper limit. In this case, the difference between the 
two spans needs to be 10.0% or greater.

See Section 2.2.

100.0

Depend ID Set the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible You can choose to show or hide this component by setting 
[On] or [Off].

See Section 2.2.

On

Sync act See Section 2.2.

Note
•	 To display the indicator bar and color scale band configured when you set the type to [Bitmap], 

you will need to fill the background of bitmap with R:252, G:228, and B:180.
•	 Conditions for reading a bitmap

(1)	Do not compress down to a format of 256 colors or fewer
(2)	640 (width) x 480 (height) pixels or fewer (the bitmap cannot be read if the value exceeds 

either 640 or 480.)

When scale marks overlap
•	 When selecting [Micro] for the mark format
	 If the scale positions of multiple channels overlap, their marks overlap. When 

overlapping, marks are staggered to prevent their points from overlapping, but when 
the scale format is [Small] or [Large] with 4 or more, or 6 or more marks respectively, 
the points will overlap.

	 Example of a mark display when the scale type is [Small]

				  

No. of CH: 5
No. of CH: 2
No. of CH: 3

Overlapping indicators since more than 4 marks at the same position
No overlapping indicators since 3 or fewer marks at the same position

When indicators overlap at the same position

•	 When selecting [Small] for the mark format
	 If the scale positions of multiple channels overlap, their marks overlap. If marks 

overlap, they are staggered to prevent the channel numbers from overlapping, but 
under the following conditions, the channel numbers also overlap.
•	 Waveform direction is [Vertical], scale format is [Large], and there are 4 or more 

marks
•	 Waveform direction is [Vertical], scale format is [Small], and there are 3 or more 

marks
•	 Waveform direction is [Horizontal] with 3 or more marks

	 Note that only 2 digits of the channel number are displayed.

2.6  Attributes of Scale Components
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•	 When selecting [Balanced] for the mark format
	 If there are channels of the same scale position, they are assigned with mark formats 

of left (waveform direction vertical), or up (waveform direction horizontal). In this case, 
if the number of channels with the same channel position is 3 or less (scale format 
[Small]), or 5 or less (scale format [Large]), it is assigned alternately.

			 

Mark format assignment order 
(from the left) when the waveform 
direction is [Vertical]

Mark format assignment order 
(from the top) when the waveform 
direction is [Horizontal]

	 Mark display positions overlapping when the waveform direction is [Vertical] and the 
scale format is [Small]

			 
When marks overlap

2.6  Attributes of Scale Components
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2.7	 Attributes of Switch Components

These components are associated with displaying a switch. You will be able to turn the 
event level switch [On]/[Off] on the execution screen.
Component type
(See Section 1.4.)

Components with 
action functions

Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec

Name of Each Component

		

Selector Seesaw Lever SlideX SlideY Push Power Connector Toggle

Switch On 

Switch Off 

Off string 

On string 

String display Off

To execute the configured action on the execution screen, select a component using the 
up and down arrow keys and press DISP/ENTER. If the confirmation dialog is set to [On], 
the following dialogs appear before executing the action.

		

Attribute Setting Dialog
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List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
0 to 79

Style Set the type of switch.  
Selectable from among [Selector], [Seesaw], [Lever], 
[SlideX], [SlideY], [Push], [Power], [Connector] and 
[Toggle]. (See “name of each component” for more 
information.)

Selector

Event level switch Set the event level switch number. You can select a 
number between [1] and [30].

1

Action prompt You can choose to display a confirmation dialog when 
executing an action by setting [On] or [Off].

On

Font Set the size of On/Off strings. You can select [Font 5], 
[Font 6], [Font 8], [Font 12], or [Font 16].

Font 6(DX1000) 
Font 8(DX2000)

String display You can choose to show or hide the string display by 
setting [On] or [Off].

On

Gap Set the character gap of the string. You can set a value 
between 0 and 15.

0

Color Set the color of a switch. 
Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], and [BASE].

L.brown

On color Set the color when the switch is turned On. (Available 
On color is same as those listed in Color.)

Cyan

Off color Set the color when the switch is turned Off. (Available 
Off color is same as those listed in Color.)

BASE

On string Set the string when the switch is turned On. You can 
enter up to 8 one-byte characters.

ON

Off string Set the string when the switch is turned Off. You can 
enter up to 8 one-byte characters.

OFF

Frame Set the frame of a component.
See page 2-2.

Raised

Depend ID Set the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible You can choose to show or hide this component by 
setting [On] or [Off].

See Section 2.2.

On

Sync act See Section 2.2.

2.7  Attributes of Switch Components
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2.8	 Attributes of Label Components

These components are associated with displaying a label. Strings configured will be 
displayed.
Component type
(See Section 1.4.)

Label Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		

Label display area

Label (string)

Vertical display: On

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
0 to 79

Text label Set the string to be displayed. You can enter up to 64 
one-byte characters.

Label

Font Set the character size of a label (string). You can select 
[Font 5], [Font 6], [Font 8], [Font 12], [Font 16], or [Font 
32].

Font 6(DX1000) 
Font 8(DX2000)

Arrangement Set the horizontal arrangement of the string. You can 
select [Center], [Left], or [Right].

Left

Color Set the color of the string. Selectable from among [Red], 
[Green], [Blue], [B.violet], [Brown], [Orange], [Y.green], 
[Lightblue], [Violet], [Gray], [Lime], [Cyan], [Darkblue], 
[Yellow], [Lightgray], [Purple], [Pink], [L.brown], 
[L.green], [Darkgray], [Olive], [Darkcyan], [S.green], 
[Black], [White], and [BASE].

Black

Background color Set the fill color of the label display area. Selectable 
from among [Red], [Green], [Blue], [B.violet], [Brown], 
[Orange], [Y.green], [Lightblue], [Violet], [Gray], [Lime], 
[Cyan], [Darkblue], [Yellow], [Lightgray], [Purple], [Pink], 
[L.brown], [L.green], [Darkgray], [Olive], [Darkcyan], 
[S.green], [Black], [White], [BASE].and [None].

None

Gap Sets the gap between characters in a text label. 
Can be set in the range from 0 to 15.

0

Continued on the next page
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Attribute Description Default value
Vertical display Sets whether or not to display the tag number vertically.

[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Off

Frame Set the frame of a component.
See page 2-2.

None

Depend ID Set the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible You can choose to show or hide this component by 
setting [On] or [Off].

See Section 2.2.

On

Sync act See Section 2.2.

2.8  Attributes of Label Components



2-20 IM 04L41B01-04E

2.9	 Attributes of Tag No. Components

These components are associated with displaying Tag No.
(Soft key menu will be displayed when you set the Tag No. to [Yes] at the basic setting 
mode.)
Component type
(See Section 1.4.)

Channel assignment Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		

Tag No. display area

Tag No. (string)

Vertical display: On

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
0 to 79

Channel no Set the channel number to be assigned.
You can configure this field when the group control is 
set to [None].

1

Font Set the character size of Tag No. You can select [Font 5], 
[Font 6], [Font 8], [Font 12], or [Font 16].

Font 6(DX1000) 
Font 8(DX2000)

Arrangement Set the horizontal arrangement of the string. You can 
select [Center], [Left], or [Right].

Left

Color Set the color of the string. Selectable from among [Red], 
[Green], [Blue], [B.violet], [Brown], [Orange], [Y.green], 
[Lightblue], [Violet], [Gray], [Lime], [Cyan], [Darkblue], 
[Yellow], [Lightgray], [Purple], [Pink], [L.brown], 
[L.green], [Darkgray], [Olive], [Darkcyan], [S.green], 
[Black], [White], [BASE], and [Channel].

White

Background color Set the fill color of the tag no. display area. Selectable 
from among [Red], [Green], [Blue], [B.violet], [Brown], 
[Orange], [Y.green], [Lightblue], [Violet], [Gray], [Lime], 
[Cyan], [Darkblue], [Yellow], [Lightgray], [Purple], [Pink], 
[L.brown], [L.green], [Darkgray], [Olive], [Darkcyan], 
[S.green], [Black], [White], [BASE], [Channel], and 
[None].

BASE

Continued on the next page
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Attribute Description Default value
Gap Set the character gap of the string. You can set a value 

between 0 and 15.
0

2 Line display You can choose to display the tag no. in two lines by 
setting [On] or [Off].

Off

Vertical display Sets whether or not to display the tag number vertically.
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Off

Frame Set the frame of a component.
See Section 2.2.

None

Depend ID Set the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible You can choose to show or hide this component by 
setting [On] or [Off].

See Section 2.2.

On

Group control Set the control status of group displayed.
See Section 1.11 and Section 2.2.

None

Gr.Ctrl order Set the control order of group displayed.
See Section 1.11 and Section 2.2.

1

Sync act See Section 2.2.

2.9  Attributes of Tag No. Components
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2.10	 Attributes of Tag Comment Components

These components are associated with displaying tag comment (tag).
Component type
(See Section 1.4.)

Channel assignment Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		

Tag comment display area

Tag comment (string)

Vertical display: On

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification
0 to 79

Channel no Set the channel number to be assigned.
You can configure this field when the group control is 
set to [None].

1

Font Set the character size of the tag. You can select [Font 5], 
[Font 6], [Font 8], [Font 12], or [Font 16].

Font 6(DX1000) 
Font 8(DX2000)

Arrangement Set the horizontal arrangement of the string. You can 
select [Center], [Left], or [Right].

Left

Color Set the color of the string. Selectable from among [Red], 
[Green], [Blue], [B.violet], [Brown], [Orange], [Y.green], 
[Lightblue], [Violet], [Gray], [Lime], [Cyan], [Darkblue], 
[Yellow], [Lightgray], [Purple], [Pink], [L.brown], 
[L.green], [Darkgray], [Olive], [Darkcyan], [S.green], 
[Black], [White], [BASE], and [Channel].

White

Background color Set the fill color of the tag comment display area.
Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], 
[Olive], [Darkcyan], [S.green], [Black], [White], [BASE], 
[Channel], and [None].

BASE

Continued on the next page
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Attribute Description Default value
Gap Set the character gap of the string. You can set a value 

between 0 and 15.
0

2 Line display You can choose to display the tag comment in two lines 
by setting [On] or [Off].

Off

Vertical display Sets whether or not to display the tag comment 
vertically.
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Off

Frame Set the frame of a component.
See Section 2.2.

None

Depend ID Set the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible You can choose to show or hide this component by 
setting [On] or [Off].

See Section 2.2.

On

Group control Set the control status of group displayed.
See Section 1.11 and Section 2.2.

None

Gr.Ctrl order Set the control order of group displayed.
See Section 1.11 and Section 2.2.

1

Sync act See Section 2.2.

2.10  Attributes of Tag Comment Components
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2.11	 Attributes of Simple Digital Components

These components are associated with displaying digital values.
Component type
(See Section 1.4.)

Channel assignment Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec

Name of Each Component

		
Digital value 

Simple digital display area (Frame: Sunken) 

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component identification 0 to 79
Channel no Set the channel number to be assigned. You can configure 

this field when the group control is set to [None].
1

Font Set the character size of digital value. You can select 
[Font 5], [Font 6], [Font 8], [Font 12], [Font 16], or [Font 32].

Font 6(DX1000) 
Font 8(DX2000)

Color Set the color of digital value. Selectable from among 
[Red], [Green], [Blue], [B.violet], [Brown], [Orange], 
[Y.green], [Lightblue], [Violet], [Gray], [Lime], [Cyan], 
[Darkblue], [Yellow], [Lightgray], [Purple], [Pink], 
[L.brown], [L.green], [Darkgray], [Olive], [Darkcyan], 
[S.green], [Black], [White], [BASE], and [Channel]..

Blue

Alarm color Set the color of digital value when the alarm is turned 
on. Selectable from among [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], [Y.green], [Lightblue], 
[Violet], [Gray], [Lime], [Cyan], [Darkblue], [Yellow], 
[Lightgray], [Purple], [Pink], [L.brown], [L.green], 
[Darkgray], [Olive], [Darkcyan], [S.green], [Black], 
[White], [BASE], [Channel], and [Alarm].

Alarm

Background color Set the fill color of digital value area. (Background colors 
available are same as those listed in alarm color.)

BASE

BG transparent You can choose to make the background color 
transparent by setting [On] or [Off].
BG color will become transparent when the simple 
digital completely overlaps the trend display 
components located underneath. This transparency 
is invalid if the simple digital protrudes from the trend 
display component.

Off

Frame Set the frame of a component. See page 2-2. None
Depend ID Set the ID number of the component on which this 

component is dependent. See Section 2.2.
None

Visible You can choose to show or hide this component by 
setting [On] or [Off]. See Section 2.2.

On

Group control Set the control status of group displayed.
See Section 1.11 and Section 2.2.

None

Gr.Ctrl order Set the control order of group displayed.
See Section 1.11 and Section 2.2.

1

Sync act See Section 2.2.
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2.12	 Attributes of Simple Bar Graph Components

These components are associated with displaying a bar graph. You can display a bar 
graph and alarm set-point mark.
Component type
(See Section 1.4.)

Channel assignment Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec

Name of Each Component

		

Direction: Vertical 

Direction: Horizon 

Background
color: White

Attribute Setting Dialog

		

Pressing the [+] button increases the number of alarm marks. 
Pressing the [–] button decreases the number of alarm marks. 

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component identification. 0 to 79
Channel no Set the channel number to be assigned. You can 

configure this field when the group control is set to 
[None].

1

Alarm mark Set how many alarm set-point marks will be displayed 
on a simple bar graph. You can set up to four marks.

None

Base position Set the base position of a bar graph. You can select 
[SET], [Normal], [Center], [Lower], or [Upper].

SET

Direction Set the direction of a bar graph. You can select either 
[Vertical] or [Horizon]. The default value will depend on 
the aspect ratio of component size drawn.

Depend on the 
aspect ratio of 
component size
Length≥ Width: 
Vertical
Length < Width: 
Horizon

Color scale band Set how the color scale band is displayed. You can 
select [Off] or [SET].

SET

Color Set the color of a bar. Selectable from among [Red], 
[Green], [Blue], [B.violet], [Brown], [Orange], [Y.green], 
[Lightblue], [Violet], [Gray], [Lime], [Cyan], [Darkblue], 
[Yellow], [Lightgray], [Purple], [Pink], [L.brown], 
[L.green], [Darkgray], [Olive], [Darkcyan], [S.green], 
[Black], [White], [BASE], and [Channel]

Channel

Background color Set the fill color of the bar graph area. (Background 
colors available are same as those listed in Color.)

BASE

Continued on next page
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Attribute Description Default value
Color change 
(alarm on)

You can choose to change the bar color when alarm is 
turned on by setting [On] or [Off].

Off

Alarm color Set the bar color when alarm is turned on. Selectable 
from among [Red], [Green], [Blue], [B.violet], [Brown], 
[Orange], [Y.green], [Lightblue], [Violet], [Gray], [Lime], 
[Cyan], [Darkblue], [Yellow], [Lightgray], [Purple], [Pink], 
[L.brown], [L.green], [Darkgray], [Olive], [Darkcyan], 
[S.green], [Black], [White], [BASE], [Channel], and 
[Alarm]. You can set this field only when the color 
change field is set to [On].

Alarm

Scale line You can choose to show or hide the scale line of bar 
graph by setting [On] or [Off].

On

Depend ID Set the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible You can choose to show or hide this component by 
setting [On] or [Off].

See Section 2.2.

On

Group control Set the control status of group displayed.
See Section 1.11 and Section 2.2.

None

Gr.Ctrl order Set the control order of group displayed.
See Section 1.11 and Section 2.2.

1

Sync act See Section 2.3.

2.12  Attributes of Simple Bar Graph Components
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Attributes of Alarm Set-point Mark Components
This section explains alarm set-point mark components displayed in a simple bar graph.
Component type
(See Section 1.4.)

Channel assignment Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec

Name of Each Component

		

Alarm mark 

Direction: Vertical 

Direction: Horizontal 

Attribute Setting Dialog

		

• The soft key menu for the number of alarm marks will be displayed only when the cursor is positioned here.
• When you press the soft key, screen shows the “alarm mark” dialog, which allows you to configure the attribute
  of each alarm mark.

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification
0 to 79

Alarm level Set the alarm level. You can select a level between [1] 
and [4].

1

Style Set the shape of alarm set-point mark. You can select 
either [Alarm] or [Fixed].

Alarm

Position Set where to display the alarm set-point mark. For a 
vertical bar graph, you can select either [Left] or [Right]. 
For a horizontal bar graph, you can select either [Over] 
or [Under].

Bar graph 
Vertical: [Right] 
Horizontal: 
[Under]

Color change 
(alarm on)

You can choose to change the color of alarm mark 
when alarm is turned on by setting [On] or [Off].

On

Mark size Set the size of alarm set-point mark. You can select 
either [Small] or [Large].

Large

Color Sets the color of the alarm set point mark.
Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], and [Channel].

Lime

Alarm color Set the color of alarm set-point mark when the alarm 
is on. Selectable from among [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], [Y.green], [Lightblue], 
[Violet], [Gray], [Lime], [Cyan], [Darkblue], [Yellow], 
[Lightgray], [Purple], [Pink], [L.brown], [L.green], 
[Darkgray], [Olive], [Darkcyan], [S.green], [Black], 
[White], [Channel], and [Alarm].

Alarm

Visible You can choose to show or hide this component by 
setting [On] or [Off]. 

See Section 2.2.

On

2.12  Attributes of Simple Bar Graph Components
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2.13	 Attributes of Unit Components

These components are associated with displaying a unit.
Component type
(See Section 1.4.)

Channel assignment Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		

Unit display area

Unit (string)

Vertical display: On

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component identification. 0 to 79
Channel no Set the channel number to be assigned. 

You can configure this field when the group control is 
set to [None].

1

Font Set the character size of unit font. You can select [Font 
5], [Font 6], [Font 8], [Font 12], or [Font 16].

Font 6 (DX1000) 
Font 8 (DX2000)

Arrangement Set the horizontal arrangement of the string. You can 
select [Center], [Left], or [Right].

Right

Color Set the color of the string. Selectable from among [Red], 
[Green], [Blue], [B.violet], [Brown], [Orange], [Y.green], 
[Lightblue], [Violet], [Gray], [Lime], [Cyan], [Darkblue], 
[Yellow], [Lightgray], [Purple], [Pink], [L.brown], 
[L.green], [Darkgray], [Olive], [Darkcyan], [S.green], 
[Black], [White], [BASE], and [Channel].

White

Background color Set the fill color of the unit display area. Selectable 
from among [Red], [Green], [Blue], [B.violet], [Brown], 
[Orange], [Y.green], [Lightblue], [Violet], [Gray], [Lime], 
[Cyan], [Darkblue], [Yellow], [Lightgray], [Purple], [Pink], 
[L.brown], [L.green], [Darkgray], [Olive], [Darkcyan], 
[S.green], [Black], [White], [BASE], [Channel], and 
[None].

BASE

Gap Set the character gap of the string. You can set a value 
between 0 and 15.

0

Vertical display Sets whether or not to display the units vertically.
[On]: Rotates the text label 90 degrees clockwise.
[Off]: Displays the text label horizontally. 

Off

Frame Set the frame of a component.
See Section 2.2.

None

Continued on the next page
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Attribute Description Default value
Depend ID Set the ID number of the component on which this 

component is dependent. See Section 2.2.
None

Visible You can choose to show or hide this component by 
setting [On] or [Off]. See Section 2.2.

On

Group control Set the control status of group displayed. 
See Section 1.11 and Section 2.2.

None

Gr.Ctrl order Set the control order of group displayed.
See Section 1.11 and Section 2.2.

1

Sync act See Section 2.2.

2.13  Attributes of Unit Components



2-30 IM 04L41B01-04E

2.14	 Attributes of Alarm Indicator Components

These components are associated with displaying an alarm indicator.
Component type
(See Section 1.4.)

Channel assignment Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec

Name of Each Component

		
Alarm kind display 

Alarm indictor display area 

Attribute Setting Dialog

		

• Select [All] at the alarm  
  level field. 

[Change] button appears. 

Set the alarm color for each alarm level. 

• Select the [Change] button.
Alarm color dialog box appears.

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component identification. 0 to 79
Channel no Set the channel number to be assigned. You can 

configure this field when the group control is set to [None].
1

Alarm level Sets the alarm level to be assigned. Selectable from 
among [1], [2], [3], [4], and [All]. Selecting [All] allows 
an alarm color to be set for each level.

1

Alarm color Sets the color when the alarm is on. Selectable from 
among [Red], [Orange], [Lime], [Yellow], [Pink], [Black], 
[White], and [Alarm].

Alarm

Color Sets the color used when the alarm is off. Selectable 
from among [Red], [Orange], [Lime], [Yellow], [Pink], 
[Black], and [White].

Lime

Alarm kind 
display

Sets [On] or [Off] to indicate whether or not the alarm 
type is displayed. Setting [On] displays the alarm type 
(symbol) set for each alarm level.

On

Frame Sets the component frame.
See Section 2.2.

Raised

Depend ID Set the ID number of the component on which this 
component is dependent. See Section 2.2.

None

Visible You can choose to show or hide this component by  
setting [On] or [Off]. See Section 2.2.  

On

Group control Set the control status of the display group.
See Section 1.11 and Section 2.2.

None

Gr.Ctrl order Sets the registration order of the display group.
See Section 1.11 and Section 2.2.

1

Sync act See Section 2.2.
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2.15 	 Attributes of Span Lower Limit (Span Upper 
Limit) Components

These components are used to display span lower and upper limits.  (Here, the span 
lower limit is explained. However, this explanation can also apply to the span upper llimit 
if you replace “lower limit” with “upper limit.”))
Component type
(See Section 1.4.)

Channel assignment Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		

Span display area

Span lower limit / 
Span upper limit 
(string)

Vertical display: On

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component identification. 0 to 79
Channel no Sets the channel number to be assigned. You can 

configure this field when the group control is set to [None].
1

Font Sets the character size of the lower limit (upper limit) 
span. You can select [Font 5], [Font 6], [Font 8], [Font 
12], or [Font 16].

Font 6(DX1000) 
Font 8(DX2000)

Arrangement Sets the horizontal arrangement of the string in the 
lower limit (upper limit) span display area.  Selectable 
from [Center], [Left], and [Right].

Left

Color Set the color of the string. Selectable from among [Red], 
[Green], [Blue], [B.violet], [Brown], [Orange], [Y.green], 
[Lightblue], [Violet], [Gray], [Lime], [Cyan], [Darkblue], 
[Yellow], [Lightgray], [Purple], [Pink], [L.brown], 
[L.green], [Darkgray], [Olive], [Darkcyan], [S.green], 
[Black], [White], [BASE], and [Channel].

White

Background color Sets the fill color of the span display area. Selectable 
from among [Red], [Green], [Blue], [B.violet], [Brown], 
[Orange], [Y.green], [Lightblue], [Violet], [Gray], [Lime], 
[Cyan], [Darkblue], [Yellow], [Lightgray], [Purple], [Pink], 
[L.brown], [L.green], [Darkgray], [Olive], [Darkcyan], 
[S.green], [Black], [White], [BASE], [Channel] and 
[None].

BASE

Gap Sets the character gap of the string. You can set a 
value between 0 and 15.

0

Vertical display Sets whether or not to display the SpanU/SpanL text 
label vertically.
[On]: Rotates the text label 90 degrees clockwise.
[Off]: Displays the text label horizontally.

Off

Frame Sets the component frame.
See Section 2.2.

None

Continued on the next page
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Attribute Description Default value
Depend ID Set the ID number of the component on which this 

component is dependent. See Section 2.2.
None

Visible Sets [On] or [Off] to indicate whether or not this 
component is displayed. See Section 2.2.

On

Group control Set the control status of the display group.
See Section 1.11 and Section 2.2.

None

Gr.Ctrl order Sets the registration order of the display group.
See Section 1.11 and Section 2.2.

1

Sync act See Section 2.2.

2.15   Attributes of Span Lower Limit (Span Upper Limit) Components
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2.16	 Attributes of Message List Components

These components are used to display the message list.
Component type
(See Section 1.4.)

List display Overlap restriction
(See Section 1.4.)

A Update 
cycle

1 sec

Name of Each Component

		

Header (quantity, title) 

Message string 
Message mark 

Attribute Setting Dialog

		

(*)

* The Batch group no. will be displayed only when Multi  batch (additional specification /BT2) is valid.

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
80 to 83

Font Sets the character size of the message list. You can 
select either [Font 6] or [Font 8].

Font 6(DX1000) 
Font 8(DX2000)

Batch group no 
 
 
only with additional 
spec. /BT2

Sets the batch group number. Selectable from among 
the number of multi batches configured in the basic 
setting.  
The batch group number will be displayed only when 
Multi batch is valid.

1

Color Set the color of the string. Selectable from among [Red], 
[Green], [Blue], [B.violet], [Brown], [Orange], [Y.green], 
[Lightblue], [Violet], [Gray], [Lime], [Cyan], [Darkblue], 
[Yellow], [Lightgray], [Purple], [Pink], [L.brown], 
[L.green], [Darkgray], [Olive], [Darkcyan], [S.green], 
[Black], [White], and [BASE].

Black

Background color Sets the fill color of the message list area.  Selectable 
from among [white] and [black].

White

BG transparent You can choose to make the background color 
transparent by setting [On] or [Off].
The background transparency is valid when the trend 
display component exists under the message list that 
completely overlaps with it.  This transparency is invalid 
if the message list protrudes from the trend display 
component.

Off

Header display Sets [On] or [Off] to indicate whether or not the header 
is displayed. Setting On displays this item on the 
execution screen.  The builder screen always hides this 
item.

Off

Mark display Sets [On] or [Off] to indicate whether or not the 
message mark is displayed.  Setting On displays this 
item on the execution screen.  The builder screen 
always hides this item.

On

Continued on next page
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Attribute Description Default value
Time display Sets [On] or [Off] to indicate whether or not the time 

is displayed.  Setting On displays this item on the 
execution screen.  The builder screen always hides this 
item.

On

NoDate display Sets [On] or [Off] to indicate whether or not the date 
is displayed.  Settable when the time display is On.  If 
NoDate display is set to Off, the date appears.

On

Group display Sets [On] or [Off] to indicate whether or not the write 
group is displayed.

Off

User display Sets [On] or [Off] to indicate whether or not the write 
user is displayed.
When On, the action function is added to enable the 
message and user displays to be switched on the 
execution screen.

Off

2 Line display Sets [On] or [Off] to indicate whether or not the 
message is displayed in two lines.

Off

Frame Sets the component frame.
See page 2-2.

Raised

Depend ID Set the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible Sets [On] or [Off] to indicate whether or not this 
component is displayed. 

See Section 2.2.

On

Sync act See Section 2.2.

2.16  Attributes of Message List Components
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2.17	 Attributes of Alarm List Components

These components are used to display the alarm list.
Component type
(See Section 1.4.)

List display Overlap restriction
(See Section 1.4.)

A Update 
cycle

1 sec

Name of Each Component

		

Header (quantity, title) 

Alarm level and type 
Tag comment, Tag No. or Channel No. 
Alarm event type (mark and string) 

Attribute Setting Dialog

		

(*)

* The Batch group no. will be displayed only when Multi batch (additional specification /BT2) is valid.

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
80 to 83

Font Sets the character size of alarm list. You can select either 
[Font 6] or [Font 8].

Font 6(DX1000) 
Font 8(DX2000)

Batch group no 
 
only with additional 
spec. /BT2

Sets the batch group number. You can select a number 
from [1] to [6] for DX1000, [1] to [12] for DX2000. 
The batch group number will be displayed only when 
Multi batch is valid.

1

Color Set the color of the string. Selectable from among [Red], 
[Green], [Blue], [B.violet], [Brown], [Orange], [Y.green], 
[Lightblue], [Violet], [Gray], [Lime], [Cyan], [Darkblue], 
[Yellow], [Lightgray], [Purple], [Pink], [L.brown], [L.green], 
[Darkgray], [Olive], [Darkcyan], [S.green], [Black], [White], 
and [BASE].

Black

Background color Sets the fill color of the alarm list area. Selectable from 
among [white] and [black].

White

Display mode Sets the display mode. Selectable from [List] or [Watch].
[List]	 Displays all alarms.
[Watch]	 Displays the alarms being generated.

Displays the alarms being generated, from 
among alarm data (up to 250 data items) 
retained for internal memory display. If alarms 
occur frequently, they are not displayed even 
if they are being generated since they are 
discarded starting with older data.

List

Continued on next page
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Attribute Description Default value
BG transparent Sets [On] or [Off] to indicate whether or not the 

background color is made transparent.
The background transparency is valid when the trend 
display component exists under the alarm list that 
completely overlaps with it.  This transparency is invalid if 
the alarm list protrudes from the trend display component.

Off

Header display Sets [On] or [Off] to indicate whether or not the header is 
displayed. Setting On displays this item on the execution 
screen.  The builder screen always hides this item.

Off

Mark display Sets [On] or [Off] to indicate whether or not the alarm 
event type is displayed. Setting On displays this item on 
the execution screen. The builder screen always hides 
this item.

On

Lv&Kind display Sets [On] or [Off] to indicate whether or not the alarm 
level and type are displayed.

On

Time display Sets [On] or [Off] to indicate whether or not the time is 
displayed.  Setting On displays this item on the execution 
screen.  The builder screen always hides this item.

On

NoDate display Sets [On] or [Off] to indicate whether or not the date is 
displayed.  Settable when Time display is On.  If NoDate 
display is set to Off, the date appears.

Off

2 Line display You can choose to display the tag no. in two lines by 
setting [On] or [Off].

Off

Frame Set the frame of a component.
See Section 2.2.

Raised

Depend ID Set the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible Sets [On] or [Off] to indicate whether or not this 
component is displayed.

See Section 2.2.

On

Sync act See Section 2.2.

2.17  Attributes of Alarm List Components
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2.18	 Attributes of Bitmap Components

These components are used to display a bitmap. The bitmap corresponds to the format 
having 256 or fewer colors. Bitmap components can be used as screen backgrounds, 
trend grids, and scales of trend components. 
Component type
(See Section 1.4.)

Still image display Overlap restriction
(See Section 1.4.)

B Update 
cycle

None

Name of Each Component

		

Bitmap display area 

If the size of bitmap file read
goes over the display area,
the images out of the area
will not be displayed. 

Note
Conditions for reading a bitmap

(1) Uncompressed format with 256 colors or fewer
(2)	640 (width) x 480 (height) pixels or less (the bitmap cannot be read if the value exceeds 

either 640 or 480.)
•	 Make sure that the bitmap image information meets the conditions.
•	 When using a paint program to create a bitmap, save it as a monochrome, 16-color, or 

256-color bitmap.

Attribute Setting Dialog

		

If you select here, the read destination directory
of the bitmap appears. 

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
132 to 133

Bmp filename Enter the name of a bitmap file saved on an external 
storage medium (CF card).
The read destination is the directory used when the 
screen was loaded.

Bitmap.bmp

Continued on the next page



2-38 IM 04L41B01-04E

Attribute Description Default value
Disp. on editing Sets [On] or [Off] to indicate whether or not the bitmap 

is displayed on the builder screen.
Off

Trend grid mode Sets [On] or [Off] to indicate whether or not it should 
act as the grid of the trend component.
If this item is turned On, when a trend component ID 
is specified for a Depend ID, the [Disp. on editing] 
item is On, its background turns gray, and it cannot be 
selected. Also, the [Image processing] item turns Off, 
its background turns gray, and it cannot be selected.
If this item is turned Off, when a trend component ID is 
specified for a Depend ID, the backgrounds of the [Disp. 
on editing] and [Image processing] items turn white, 
and they can be selected. 

Off

Image processing Sets [On] or [Off] to indicate whether or not the image 
processing is converted when the bitmap file is read. 
If On, the bitmap file is optimized to the display of this 
equipment. However, it takes time until the bitmap 
appears. About 30 seconds is required when the image 
size is 640 x 480 pixels

Off

Depend ID Set the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible Sets [On] or [Off] to indicate whether or not this 
component is displayed.

See Section 2.2.

On

Sync act See Section 2.2.

Note
•	 If [Image processing] is set to On, it may take time to display created custom display 

screens. To save time, turn it Off. 
•	 Bitmap files are placed in the same directory as custom display screen setting files (.DCD). 

If they are in the wrong directory, the bitmaps will not be able to be displayed. 
•	 If a custom display screen using a bitmap component is created in internal memory, display 

the bitmap in the execution panel after the screen is created. To display bitmaps later on 
that have never been displayed previously, the external storage media (CF card) containing 
them must be inserted into the instrument. 

•	 When completely overlapping bitmap components of the same size and switching between 
them on the DX, the external storage media (CF card) holding those bitmap files must be 
inserted into the instrument. 

•	 It is possible to display bitmap files used in custom display screens saved to internal 
memory even if the bitmap files are saved to an external storage medium that is not 
inserted, but the following conditions must be met. 
	 Internal memory capacity of 400 MB or more (check the MEMORY item in the system 

information screen). 
•	 When loading screens or moving from the builder screen to the execution panel, the bitmap 

files in the external storage media (CF card) are copied to the internal memory. Be sure to 
save all bitmap files being used in the screen to the external storage media (CF card). When 
displaying custom display screens saved to internal memory, an error message appears if 
specified bitmap files are not found. 

•	 Even if bitmap files are specified in the attributes, an error message does NOT appear if the 
bitmap files are not present during a copy operation. Check the attributes for the presence/
absence of bitmap files. 

2.18  Attributes of Bitmap Components
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2.19	 Attributes of Group Name Components

This component displays the group name corresponding to the specified group number.
If you want to display components in a custom display of not only the same group but 
of several groups, or if you set the status area to No display and thereby eliminate the 
group name, you can create this group name component to display group names.
Component type
(See Section 1.4.)

Status display 
component

Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		

Group name

Component area

If you set Change group to On in the 
property settings, the group name changes 
when you press the left/right arrow keys
on the execution panel. 

Vertical display

Attribute settings dialog box

		

(*)

* The Batch group no. will be displayed only when Multi batch (additional specification /BT2) is  
   valid.

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
0 to 79

Batch group no 
 
only with additional 
spec. /BT2

Sets the batch group number. You can select a number 
from [1] to [6] for DX1000, [1] to [12] for DX2000. 
The batch group number will be displayed only when 
Multi batch is valid.

1

Group no Set the group number.
Multi batch Off
You can select a number from [1] to [10] for DX1000, [1] 
to [36] for DX2000.
Multi batch On
You can select a number from [1] to [6] for DX1000, [1] 
to [12] for DX2000.

1

Font Set the size of On/Off strings. 
You can select [Font 5], [Font 6], [Font 8], [Font 12], or 
[Font 16].

Font 6(DX1000) 
Font 8(DX2000)

Color Set the color of a group name from among [Red], 
[Green], [Blue], [B.violet], [Brown], [Orange], [Y.green], 
[Lightblue], [Violet], [Gray], [Lime], [Cyan], [Darkblue], 
[Yellow], [Lightgray], [Purple], [Pink], [L.brown], 
[L.green], [Darkgray], [Olive], [Darkcyan], [S.green], 
[Black], [White], and [BASE].
[Background color]: The base color set for the screen. 

Black

Continued on the next page
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Attribute Description Default value
Background color Set the color of the group name.

Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], and [BASE].
[Background color]: The base color set for the screen..

None

Change group Sets whether or not to switch the group display in the 
execution panel when the left/right keys are pressed.

On

Arrangement Set the horizontal arrangement of the string.
You can select [Center], [Left], or [Right].

Left

Gap Sets the character gap of the string.
You can set a value between 0 and 15.

0

2 Line display Sets [On] or [Off] to indicate whether or not to group 
name in 2 lines with word-wrapping.

Off

Vertical display Sets whether or not to display the group name display 
vertically.
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Off

Frame Set the component frame.
See section 2.2

None

Depend ID Set the ID number of the component on which this 
component is dependent.

See section 2.2

None

Visible You can choose to show or hide this component by 
setting [On] or [Off].

See section 2.2

On

Sync act See section 2.2

2.19  Attributes of Group Name Components
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2.20	 System Icon Component Attributes 

You can create a system icon for display in the status area. You can create icons that 
display only the items you wish in the screen, and these can be used when not displaying 
the status area. 
Component type
(See Section 1.4.)

Status display 
component

Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec

Parts of the component and kinds of icons

	

Component frame

The size of the icon 
component frame is set 
under Icon size in the 
attribute settings. 

Memory sample
Alarm

CF card
Math*1

Key lock

Email
Status

Key lock & email
UserLock*2

UserLock & status*2
*1 Can only be selected with the Math option 
*2 Can only be selected with the /AS1 option 

Attribute settings dialog box

		

List of Attributes
Attribute Description Default value
ID This number is automatically assigned to identify the components. 0 to 79
Size Select a system icon size of [24] or [32]. 24 (DX1000)

32 (DX2000)
Type Select a system icon kind of [Memory sample], [Alarm], [CF card], 

[Math], [Key lock], [Email], [Status], [Key & email]*, [UserLock], or [User 
& status]*.
* �[Key & email] is the icon for [Key lock & email].  

[User & status] is the icon for [UserLock & status].

Alarm

Background color Set a background color to use within the component frame.
You can select a color of: [Red], [Green], [Blue], [B.violet], [Brown], 
[Orange], [Y.green], [Light blue], [Violet], [Gray], [Lime], [Cyan], [Dark 
blue], [Yellow], [Light gray], [Purple], [Pink], [L.brown], [L.green], [Dark 
gray], [Olive], [Dark cyan], [S.green], [Black], [White], or [Background 
color].

Background 
color

BG transparent Turns the background transparency [On]/[Off].
The background transparency is valid when a trend display 
component exists under the system icon that completely overlaps with 
it. The transparency is invalid if the system icon component protrudes 
from the trend display component.

Off

Frame Set the component frame. 
See section 2.2

None

Depend ID Set the ID number of the component on which this component is 
dependent. 

See section 2.2

None

Visible You can choose to show or hide this component by setting [On] or [Off]. 
See section 2.2

On

Sync act See section 2.2
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2.21	 Attributes of Memory Bar Components

This component appears in the status area and shows the progress of memory sampling. 
The width of the Memory bar component frame represents the file save interval (display 
data) or data length (event data), and shows the remaining time for memory sampling. 
Component type
(See Section 1.4.)

Status display 
component

Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec

Parts of the component

		

File save interval (for display data), 
or data length (for event data)

Background
Bar

Remaining memory sampling time 
For event data, the status is displayed as a text label. 

Attribute settings dialog box

		

(*)

* The Batch group no. will be displayed only when Multi batch (additional specification 
/BT2) is valid.

List of Attributes
Attribute Description Default value
ID This number is automatically assigned to identify the 

components.
0 to 79

Batch group no 
 
 
only with additional 
spec. /BT2

Sets the batch group number. 
You can select a number from [1] to [6] for DX1000, [1] 
to [12] for DX2000. 
The batch group number will be displayed only when 
Multi batch is valid.

1

Data type Select a data type of [Display] or [Event] to display in 
the Memory bar. Note that this can only be selected 
when the basic setting mode memory data type is set 
to Event + display. If the data type is set to Display or 
Event, it cannot be selected, and reverts to the data 
type setting. 

Display (or 
Event when the 
memory type 
of Basic setting 
mode is Event)

Direction Sets the direction of bar graphs. 
You can set [Vertical] or [Horizontal]. The default 
value differs depending on the vertical-to-horizontal 
size ratio of the plotted component. 
A [Vertical] bar expands vertically from bottom to top. 
A [Horizontal] bar expands horizontally from left to 
right. 

Depends on the 
vertical-to-
horizontal ratio
Vert≥Horiz: Vert
Vert<Horiz: Horiz

Rem. time display Sets [On] or [Off] to indicate whether or not to display 
the remaining sampling time in the Rem. time display 
Memory bar.

Off

Continued on the next page
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Attribute Description Default value
Color Set the color of a bar.

You can select a color of: [Red], [Green], [Blue], 
[B.violet], [Brown], [Orange], [Y.green], [Light blue], 
[Violet], [Gray], [Lime], [Cyan], [Dark blue], [Yellow], 
[Light gray], [Purple], [Pink], [L.brown], [L.green], [Dark 
gray], [Olive], [Dark cyan], [S.green], [Black], [White], 
or [Background color].
[Background color]: The base color set for the screen. 

Lime

Background color Sets a background color.
(Background colors available are same as those 
listed in Color.)

Background color

Color(pre-Trig) Select the color of the bar during a trigger wait.
(The choices for Color(pre-Trig) are the same as 
those for Color.)
It cannot be selected in the following cases.
•	When the data type is Display data
•	�When the data type is Event data, and the event 

data mode is Free

Orange

Font Set the font for the text label that shows the remaining 
time or event data status.
Select from [Font5], [Font6], [Font8], [Font12], or 
[Font16]. 
It cannot be selected in the following cases.
•	�When the Rem. time display is Off and the data type 

is Display data
•	�When the Rem. time display is Off, the data type is 

Event data, and the mode is Free

Font 5

String color Set the display color for the text label that shows the 
remaining time or the event data status. 
(The choices of string color are the same as those for 
Color.) 
Selection is unavailable under the same conditions as 
for the Font item. 

Black

Frame Set the component frame.
See section 2.2

None

Depend ID Set the ID number of the component on which this 
component is dependent.

See section 2.2

None

Visible You can choose to show or hide this component by 
setting [On] or [Off].

See section 2.2

On

Sync act See section 2.2

2.21  Attributes of Memory Bar Components
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2.22	 Attributes of Time Label Components

This component displays the current date and time. 
You can create this date and time component if setting the status area to No display 
eliminates the date and time. 
Component type
(See Section 1.4.)

Status display 
component

Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec

Parts of the component

		
Time

Background

Date

Vertical display

Attribute settings dialog box

		

List of Attributes
Attribute Description Default value
ID This number is automatically assigned to identify the 

components.
0 to 79

Font Set the character size of current date and time.
You can select [Font 5], [Font 6], [Font 8], [Font 12], or 
[Font 16].

Font 6(DX1000) 
Font 8(DX2000)

Arrangement Set the horizontal arrangement of the string. 
You can select [Center], [Left], or [Right].

Left

Color Set the color of the current date and time.
Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], and [BASE].
[Background color]: The base color set for the screen.

Black

Background color Sets a background color.
(The choices for the background color are the same as 
those for Color, plus [None].)

BASE

BG transparent Turns the background transparency [On]/[Off]. 
When On, frames in the builder screen are shown with 
dotted lines indicating the transparent background. 
The background transparency is valid when a trend 
display component exists under the date time label 
component that completely overlaps with it. The 
transparency is invalid if the time label component 
protrudes from the trend display component. 

Off

Gap Set the character gap of the string.
You can set a value between 0 and 15.

0

Continued on the next page
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Attribute Description Default value
2 line display Sets [On] or [Off] to indicate whether or not to display 

time and date text labels in 2 lines with word-wrapping. 
This cannot be set if NoDate display is [On] or Time 
display is [Off].

Off

NoDate display Sets whether or not to display the date. 
[On] Date not displayed. 
[Off] Date displayed.

Off

Year display form Selects the year display format. 
[None]: The year is not displayed. 
[4digits]: The year is displayed in the format yyyy. 
[2digits]: The year is displayed in the format yy.

[4digits]

Time display Sets [On] or [Off] to indicate whether or not the time is 
displayed. 
This cannot be set if No Date time display is [On]. 

On

Second display Sets [On] or [Off] to indicate whether or not the 
seconds are displayed. 
The second display cannot be selected if Time display 
is set to Off.

On

Vertical display Sets whether or not to display the Time display 
vertically. 
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Off

Frame Set the component frame. 
See section 2.2

None

Depend ID Set the ID number of the component on which this 
component is dependent. 

See section 2.2

None

Visible You can choose to show or hide this component by 
setting [On] or [Off]. 

See section 2.2

On

Sync act See section 2.2

2.22  Attributes of Time Label Components
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2.23	 Attributes of Batch Group Number 
Components

This component displays the batch group number for MultiBatch. 
You can create this group name component if setting the status area to No display 
eliminates the batch group number. When MultiBatch is Off, batch group number 
components cannot be created and their attributes cannot be edited. 
Component type
(See Section 1.4.)

Status display 
component

Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Parts of the component

		
Batch group number

Background
Vertical display

Attribute settings dialog box

		

(*)

* The Batch group no. will be displayed only when Multi batch (additional specification 
/BT2) is valid.

List of Attributes
Attribute Description Default value
ID This number is automatically assigned to identify the 

components.
0 to 79

Batch group no 
 
 
only with additional 
spec. /BT2

Sets the batch group number. 
You can select a number from [1] to [6] for DX1000, [1] 
to [12] for DX2000. 
The batch group number will be displayed only when 
Multi batch is valid.

1

Font Sets the font of the text label showing the batch group 
number. 
Select from [Font5], [Font6], [Font8], [Font12], or 
[Font16].

Font 6(DX1000) 
Font 8(DX2000)

Color Sets the color of the string showing the batch group 
number. 
You can select a color of: [Red], [Green, [Blue], 
[B.violet], [Brown], [Orange], [Y.green], [Light blue], 
[Violet], [Gray], [Lime], [Cyan], [Dark blue], [Yellow], 
[Light gray], [Purple], [Pink], [L.brown], [L.green], [Dark 
gray], [Olive], [Dark cyan], [S.green], [Black], [White], 
or [Background color]. 
[Background color]: The base color set for the screen. 

Black

Background color Sets a background color.
(The choices for the background color are the same as 
those for Color, plus [None].) 

None

Disp.in 
BTOverview

When the displayed screen is in BTOverview mode, 
sets [On] or [Off] to indicate whether or not to display 
the batch group number. 

On

Text label 
arrangement

Sets the horizontal arrangement of the text label.
You can select [Center], [Left], or [Right]. 

Center

Gap Sets the gap between characters in a text label. 
Can be set in the range from 0 to 15.

0

Continued on the next page
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Attribute Description Default value
Vertical display Sets whether or not to display the batch group number 

vertically. 
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Off

Frame Set the component frame. 
See section 2.2

None

Depend ID Set the ID number of the component on which this 
component is dependent. 

See section 2.2

None

Visible You can choose to show or hide this component by 
setting [On] or [Off]. 

See section 2.2

On

Sync act See section 2.2

2.23  Attributes of Batch Group Number Components
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2.24	 Attributes of Batch Name Components

This component displays the batch name. 
You can create this batch name component if setting the status area to No display 
eliminates the batch name. 
The component displays the batch name, batch number, and lot number separated by 
hyphens. The batch and lot numbers shown in the component are the ones in the dialog 
box that appear when you press the FUNC key followed by the Batch soft key. 
When Batch is Off, batch name components cannot be created and their attributes 
cannot be edited. 
Component type
(See Section 1.4.)

Status display 
component

Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Parts of the component

		

Vertical displayBatch name

Background

Lot number
Batch number

Attribute settings dialog box

		

(*)

* The Batch group no. will be displayed only when Multi batch (additional specification 
/BT2)

List of Attributes
Attribute Description Default value
ID This number is automatically assigned to identify the 

components.
0 to 79

Batch group no 
 
 
only with additional 
spec. /BT2

Sets the batch group number. 
 You can select a number from [1] to [6] for DX1000, [1] 
to [12] for DX2000. 
The batch group number will be displayed only when 
Multi batch is valid.

1

Font Sets the font of the text label showing the batch name. 
Select from [Font5], [Font6], [Font8], [Font12], or 
[Font16]. 

Font 6(DX1000) 
Font 8(DX2000)

Color Sets the color of the string showing the batch name. 
You can select a color of: [Red], [Green, [Blue], 
[B.violet], [Brown], [Orange], [Y.green], [Light blue], 
[Violet], [Gray], [Lime], [Cyan], [Dark blue], [Yellow], 
[Light gray], [Purple], [Pink], [L.brown], [L.green], [Dark 
gray], [Olive], [Dark cyan], [S.green], [Black], [White], 
or [Background color]. 
[Background color]: The base color set for the screen. 

Black

Background color Sets a background color.
(The choices for the background color are the same as 
those for Color, plus [None].) 

Background 
color

Continued on the next page
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Attribute Description Default value
BG transparent You can choose to make the background color 

transparent by setting [On] or [Off].
The background transparency is valid when a trend 
display component exists under the batch name 
component that completely overlaps with it. The 
transparency is invalid if the batch name component 
protrudes from the trend display component.

Off

Arrangement Sets the horizontal arrangement of the text label.
You can select [Center], [Left], or [Right]. 

Left

Gap Sets the gap between characters in a text label. 
Can be set in the range from 0 to 15.

0

2 line display Sets [On] or [Off] to indicate whether or not to batch 
number and lot number in 2 lines with word-wrapping. 

Off

Vertical display Sets whether or not to display the Time display 
vertically. 
[On]: Rotates the text label 90 degrees clockwise. 
[Off]: Displays the text label horizontally. 

Off

Frame Set the component frame. 
See section 2.2

None

Depend ID Set the ID number of the component on which this 
component is dependent. 

See section 2.2

None

Visible You can choose to show or hide this component by 
setting [On] or [Off]. 

See section 2.2

On

Sync act See section 2.2

2.24  Attributes of Batch Name Components
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2.25	 Attributes of Line Components

These components are used to display a line.  A line connecting any two points is 
displayed.
Component type
(See Section 1.4.)

Shape Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		
You can draw a line going in the left/right or up/down direction from an origin.Origin

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
92 to 131

Line kind Sets line type. Selectable from among [Solid], [Dotted], 
[Dashed], and [Longdash].

Solid

Line color Sets the color of a line.
Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], and [BASE].

Black

Trend grid Sets [On] or [Off] to indicate whether or not it should 
act as the grid of the trend component dependent on 
the trend grid. 
[On]: �Plotted as the grid for the trend component of 

the Depend ID. Even when placed in front of the 
trend component, the portions that do not overlap 
with the trend component are not displayed. 

[Off]: Displayed as lines. 

Off

Depend ID Set the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible Sets [On] or [Off] to indicate whether or not this 
component is displayed.
This cannot be set if a dependent component is set. 

See Section 2.2.

On

Sync act See Section 2.2.
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2.26	 Attributes of Rectangle Components

These components are used to display a rectangle.
Component type
(See Section 1.4.)

Shape Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		

Origin

You can draw a rectangle from an origin toward the lower right. 

Background color 

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
92 to 131

Line color Sets the color of a line.
Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], [BASE], and 
[None].

Black

Background color Sets the background color.
(Background colors available are same as those listed 
in Line color.)

None

Line kind Sets line type. Selectable from among [Solid], [Dotted], 
[Dashed], and [Longdash].

Solid

Depend ID Sets the ID number of the component on which this 
component is dependent. 

See Section 2.2.

None

Visible Sets [On] or [Off] to indicate whether or not this 
component is displayed.

See Section 2.2.

On

Sync act See Section 2.2.
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2.27	 Attributes of Circle Components

These components are used to display a circle..
Component type
(See Section 1.4.)

Shape Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		

Origin

You can draw a circle
inscribed in a square. 

Background color 

You can draw a circle from an origin toward the lower right. 

You can draw a circle in
a rectangle. However,
you will not be able to
draw an ellipse. 

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification
92 to 131

Line color Sets the color of a line.
Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], [BASE], and 
[None]

Black

Background color Sets the background color.
(Background colors available are the same as those 
listed in Line color.)

None

Depend ID Sets the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible Sets [On] or [Off] to indicate whether or not this 
component is displayed.

See Section 2.2.

On

Sync act See Section 2.2.

Plotting example

		

When you set the background color without a line color 
after you have drawn a circle or rectangle, the drawings 
appear to be connected.
Combining the settings of line color and background color 
allows you to draw a more complex image.
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2.28	 Attributes of Push Button Components

These components are used to display a push button.  Using the action function allows 
the event edge switch to be switched on the execution screen as shown in the figure 
below.

Component type
(See Section 1.4.)

Components with 
action functions

Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		

Background color 
1

0
String

Event edge switch 

Action execution 

To execute the configured action on the execution screen, select a component using the 
up and down arrow keys and press DISP/ENTER.

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
0 to 79

Event edge 
switch

Sets the event edge switch number. Selectable from [1] 
and [30].

1

String You can enter up to 64 one-byte characters, as the 
string to be displayed on the button.

PushButton

Confirm dialog Sets [On] or [Off] to indicate whether or not the 
confirmation dialog is displayed during action 
execution.

On

Font Sets character size. Selectable from [Font 5], [Font 6], 
[Font 8], [Font 12], [Font 16], and [Font 32].

Font 6(DX1000) 
Font 8(DX2000)

Arrangement Sets the horizontal arrangement of the string to be 
displayed on the button.  Selectable from [Center], 
[Left], and [Right].

Center

Color Set the color of the string.
Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], and [BASE].

Black

Continued on next page
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Attribute Description Default value
Background color Sets the background color. 

Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], [BASE], and 
[None].

BASE

Depend ID Sets the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible Sets [On] or [Off] to indicate whether or not this 
component is displayed.

See Section 2.2.

On

Sync act See Section 2.2.

2.28  Attributes of Push Button Components
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2.29	 Attributes of Comment Box Components

These components are used to display a comment box.  You can display the string by 
specifying the comment box number configured for the DX main unit.
Component type
(See Section 1.4.)

Comment display Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		
Strings

Background color 

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
0 to 79

Comment box no Sets the comment box number.
1 to 100 for DX1000 and 1 to 200 for DX2000

1

Font Sets the character size.
Selectable from [Font 5], [Font 6], [Font 8], [Font 12], 
and [Font 16].

Font 6(DX1000) 
Font 8(DX2000)

Gap Sets the character gap of the string.
Settable in the range of 0 to 15.

0

Arrangement Sets the horizontal arrangement of the string.
Selectable from [Center], [Left], and [Right].

Left

Color Sets the color of the string.
Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], and [BASE].

Black

Background color Sets the background color.
Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], [BASE], and 
[None].

BASE

Frame Sets the component frame.
See page 2-2.

Black

Depend ID Sets the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible Sets [On] or [Off] to indicate whether or not this 
component is displayed.

See Section 2.2.

On

Sync act See Section 2.2.
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2.30	 Attributes of Comment Block Components

These components are used to display a comment block.  You can display the string by 
specifying the comment block number configured for the DX main unit.
Component type
(See Section 1.4.)

Comment display Overlap restriction
(See Section 1.4.)

None Update 
cycle

None

Name of Each Component

		  Strings

Background color 

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
0 to 79

Comment block 
no

Sets the comment block number.
1 to 50 for DX1000 and 1 to 100 for DX2000

1

Font Sets the character size.
Selectable from [Font 5], [Font 6], [Font 8], [Font 12], 
and [Font 16].

Font 6(DX1000) 
Font 8(DX2000)

Gap Sets the character gap of the string.  Selectable in the 
range of 0 to 15.

0

Arrangement Sets the horizontal arrangement of the string.
Selectable from [Center], [Left], and [Right].

Left

Color Set the color of the string.
Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], and [BASE].

Black

Continued on the next page



2-57IM 04L41B01-04E

A
dvanced Settings of Screen and C

om
ponent

1

2

3

App

Index

Attribute Description Default value
Background color Sets the background color.

Selectable from among [Red], [Green], [Blue], [B.violet], 
[Brown], [Orange], [Y.green], [Lightblue], [Violet], 
[Gray], [Lime], [Cyan], [Darkblue], [Yellow], [Lightgray], 
[Purple], [Pink], [L.brown], [L.green], [Darkgray], [Olive], 
[Darkcyan], [S.green], [Black], [White], [BASE], and 
[None].

BASE

Line space Sets the line space of the string. You can set a value 
between 0 and 15.

0

Frame Sets the component frame.
See Section 2.2.

Black

Depend ID Sets the ID number of the component on which this 
component is dependent.

See Section 2.2.

None

Visible Sets [On] or [Off] to indicate whether or not this 
component is displayed.

See Section 2.2.

On

Sync act See Section 2.2.

2.30  Attributes of Comment Block Components
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2.31	 Attributes of Communication Input 
Components

These components are used to write values to the communication channel. Using the action 
function enables numeric values to be written to the specified communication channel on the 
execution screen. The value written can be read from other devices using Modbus function. 
When you assign the communication channel to the computation channel, you will also be able 
to write an arbitrary value to other devices using Modbus function.
Component type
(See Section 1.4.)

Components with 
action functions

Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec

Name of Each Component

		  The character/value input window shown on the right will 
appear when you press DISP/ ENTER after selecting the 
communication input components using the up and 
down arrow keys on the execution screen.

Communication input value

Background color

Attribute Setting Dialog

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component identification. 0 to 79
Commu data no Sets the communication input data number for entering and 

displaying a value.
1

Font Sets the character size. Selectable from [Font 5], [Font 6], [Font 
8], [Font 12], [Font 16], and [Font 32].

Font 6(DX1000)  
Font 8(DX2000)

Arrangement Sets the horizontal arrangement of the string.Selectable from 
[Center], [Left], and [Right].

Right

Color Sets the color of the string. Selectable from among [Red], 
[Green], [Blue], [B.violet], [Brown], [Orange], [Y.green], 
[Lightblue], [Violet], [Gray], [Lime], [Cyan], [Darkblue], [Yellow], 
[Lightgray], [Purple], [Pink], [L.brown], [L.green], [Darkgray], 
[Olive], [Darkcyan], [S.green], [Black], [White], and [BASE].

Black

Background color Sets the background color. (Background colors available are 
same as those listed in Color.)

White

Decimal place Sets the decimal place of the device that you have connected 
using Modbus by the specification of the number of digits to the 
right of the decimal point. You can match the decimal place of 
the DX to the fixed decimal place of the connected device to 
display input values or, using action functions, write values to 
the device.
If the input value cannot be displayed using five digits, the sixth 
digit is rounded to display five significant digits in scientific 
notation.
Range: [0] to [4]
Example: If there are two decimal places
	 Setting value: 2
	 Displayed value: 123.45

0

Continued on the next page
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Attribute Description Default value
Minimum Sets the minimum value that can be input for the lower limit. -9.9999E+29
Maximum Sets the maximum value that can be input for the upper limit. 9.9999E+29
Depend ID Sets the ID number of the component on which this component 

is dependent. See Section 2.2.
None

Visible Sets [On] or [Off] to indicate whether or not this component is 
displayed. See Section 2.2.

On

Sync act See Section 2.2.

Note
Maximum and Minimum are valid only when a value is entered from the communication 
input component of the custom display.  These attributes do not influence the input from 
communication.

2.31  Attributes of Communication Input Components
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2.32	 Attributes of Modbus In Components

Creates a component that displays the input value of the communication channel set by 
the specified send command number, and that writes temperature controller and other 
SP values. 
Normally, it displays the communication input value. 
If an action function is executed, values can be written from a custom display screen to 
communication channels. 
Written values are written to registers of a connected device through specified Modbus 
send commands. 
Component type
(See Section 1.4.)

Components with 
action functions

Overlap restriction
(See Section 1.4.)

None Update 
cycle

1 sec

Parts of the component

		

Comm. In

Background color

After pressing the Up/Down arrow keys to 
select the Comm In component in the 
execution panel, you can press the 
DISP/ENTER key to display a 
character/number input window on the right. 

Attribute settings dialog box

		

List of Attributes
Attribute Description Default value
ID Number automatically assigned for component 

identification.
0 to 79

Communication Selects a communication kind of [Ethernet] or [Serial]. Ethernet
Command no. Sets the Modbus send command number specified 

under Communication. 
Range: [1] to [16]

Font Set the character size of the Modbus input.
Selectable from [Font 5], [Font 6], [Font 8], [Font 12], 
[Font 16], and [Font 32].

Font 6(DX1000)  
Font 8(DX2000)

Arrangement Sets the horizontal arrangement of the string.
Selectable from [Center], [Left], and [Right].

Right

Color Sets the color of the string showing the Modbus input. 
Sets the color of the string. Selectable from among 
[Red], [Green], [Blue], [B.violet], [Brown], [Orange], 
[Y.green], [Lightblue], [Violet], [Gray], [Lime], [Cyan], 
[Darkblue], [Yellow], [Lightgray], [Purple], [Pink], 
[L.brown], [L.green], [Darkgray], [Olive], [Darkcyan], 
[S.green], [Black], [White], and [BASE].
[Background color]: The base color set for the screen. 

Black

Background color Sets the background color. 
(Background colors available are same as those listed 
in Color.)

White

Continued on the next page
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Attribute Description Default value
Decimal place Sets the decimal place of the device that you have 

connected using Modbus by the specification of the 
number of digits to the right of the decimal point. You 
can match the decimal place of the DX to the fixed 
decimal place of the connected device to display input 
values or, using action functions, write values to the 
device.
If the input value cannot be displayed using five digits, 
the sixth digit is rounded to display five significant digits 
in scientific notation.
Range: [0] to [4]
Example: If there are two decimal places
	 Setting value: 2
	 Displayed value: 123.45

0

Minimum Sets the lower limit of the numerical value that can 
be input for the minimum. If a value larger than the 
maximum is set, the maximum takes the same value 
as the minimum. 
Selectable range:  �-9.9999E+29  to  -1.0000E-30 

0 
1.0000E-30  to  9.9999E+29

-9.9999E+29

Maximum Sets the upper limit of the numerical value that can be 
input.
If a value smaller than the minimum is set, the 
minimum takes the same value as the maximum. 
Selectable range:  �-9.9999E+29  to  -1.0000E-30 

0 
1.0000E-30  to  9.9999E+29

9.9999E+29

Depend ID Sets the ID number of the component on which this 
component is dependent. See Section 2.2.

None

Visible Sets [On] or [Off] to indicate whether or not this 
component is displayed. See Section 2.2.

On

Sync act See Section 2.2.

2.32  Attributes of Modbus In Components
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Chapter 3	 Saving and Reading Screen Data

3.1	 Saving Screen Data

Any screen configured on the builder screen can be saved in file form in an external 
storage medium (CF card). Screen data is saved in two ways: specified screen and all 
screen.

Note
After editing the [Create], or [EXTERNAL 1] through [EXTERNAL 25] screens, be sure to 
update the screen. If you do not update the screen, the edited data will be lost.  See “To Update 
an Edited Screen” in section 1.13. 

Saving the Specified Screen
The specified custom display screen setting file is saved.

Procedure
1.	 Press MENU.

2.	 On the [File] tab, select [Custom display save] > [Select].

					   

3.	 Select a screen number from the soft key menu.

					   

4.	 Press the Input soft key and enter the file name.

					   

5.	 Press DISP/ENTER.
The file is saved in the root directory.
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Explanation
Item Description
File extension CDC
File form Text
File to save Custom display screen setting file (specified screen only)

File name (optional)
Any name consisting of up to half-size 32 characters 
(alphanumerics and symbols)

Saving destination Root directory
Custom display screen 
Screen number choices

Internal 1 to 3
Custom display screen in the internal memory
External 1 to 25
Custom display screen in an external storage medium (CF card)

3.1 Saving Screen Data
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Saving All Screen
All custom display screen setting files in the internal memory and external storage 
medium (CF card) are saved in any directory specified for the external storage medium.

Procedure
1.	 Press MENU.

2.	 On the [File] tab, select [Custom display save] > [All].

					   

3.	 Press the Input soft key and enter the directory name.

					   

5.	 Press DISP/ENTER.
All screens are saved in the specified directory.

Explanation
Item Description
File to save Custom display screen setting file 

(All screen files being currently set)
File name (fixed)
Internal 1 to 3: Internal 1.CDC to Internal 3.CDC
External 1 to 25: External 1.CDC to External 25.CDC
Custom display-dedicated setting data file
File name (fixed)
Setting.CDS
All bitmap files used on the custom display screen
File name (optional)
XXX.BMP (XXX: optional)

Saving destination Specified directory
Directory name (optional)
Up to 20 characters (half-size alphanumerics and symbols)

Note
•	 The custom display screen setting file cannot be saved in USB memory.
•	 The file cannot be saved if no external storage medium (CF card) is inserted or an error is 

occurring.
• 	 The file name is not a screen name. The screen name set on the builder screen is saved 

intact in the custom display screen setting file.

3.1 Saving Screen Data
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3.2	 Reading Screen Data

The screen data (custom display screen setting file) saved on external storage medium 
(CF card) can be read in the internal memory. Screen data is read in two ways: specified 
screen and all screen.

Reading the Specified Screen
The specified screen data (custom display screen setting file) is read.

Procedure
1.	 Press MENU.

2.	 On the [File] tab, select [Custom display load] > [Select].

					   

3. 	 Select the screen number of the read destination from the soft key menu.
You can select the screen number from among internal 1 to 3 and external 1 to 25 (see the 
next page).

Reading internal 1 to 3 Reading external 1 to 25

Screen names displayed 
in the submenu

Presence/absence of data

File names displayed 
in the file list

4. 	 Select the directory containing the file to be read.
Only the custom display screen setting file (CDC) appears.
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5. 	 Select the file to be read.
The specified custom display screen setting file is read.

		

If external 1 to 25 are specified for file reading:
The selected custom display screen setting file is copied onto the external storage 
medium (CF card). If the file already exists, the following message appears:

					   

Note
•	 If the capacity of the external storage medium (CF card) is insufficient, no file can be read 

with external 1 to 25 specified.
• 	 The copy destination directory is the one used when the full screen is read last.
• 	 If the capacity of the internal memory is 400 MB or more, the bitmaps can be displayed even 

if an external storage media (CF card) associated with screens in internal memory is not 
inserted. 

• 	 When loading screens or moving from the builder screen to the execution panel, the bitmap 
files in the CF card are copied to the internal memory.

3.2 Reading Screen Data
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Reading All Screen
The specified directory is set as the read destination and custom display screen setting 
files are read in the internal memory.

Procedure
1.	 Press MENU.

2.	 On the [File] tab, select [Custom display load] > [All].

					   

3.	 Select a directory and press DISP/ENTER.

					   

All custom display screen setting files are read.

Explanation
If screen data loading (Select, All) is executed, the screen name displayed on the custom 
screen submenu of the operation screen menu is updated.
If screen data loading (All) is executed, the specified directory becomes the read 
destination directory (the default is the root directory of the external storage medium (CF 
card)).

Notes on Screen Data Saving and Reading
To use the custom display screen from external storage medium (CF card), the CF card 
in which the screen is saved needs to be always inserted.
To allow the custom display screen of DX in use to be used with another DX, save that 
screen in the CF card of another DX.

3.2 Reading Screen Data
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Appendix 1	 Example of Creating a Custom Display

You can create the screen in the figure below. 
This is for a DX1000 screen, with the MultiBatch function On.

		

Digital component
Bar component

Group name component 
(when not in MultiBatch mode, GROUP 1 is displayed)

Scale component

Tag(Comment) component

Trend component

Creating components
Procedure

1.	 Press the DISP/ENTER key.
The Screen menu appears.

2.	 Using the up and down arrow keys, select [INTERNAL 2], then press the DISP/
ENTER key. 
The execution panel is displayed.

					   

3.	 Press the FUNC key, then press the Builder soft key in the action menu. 
The Builder screen is displayed.

					   

Appendix
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4.	 Using the arrow keys, move the cursor to the start position for creating the 
component.

5.	 Press the TOOL BOX soft key.

6.	 Press the DIGITAL soft key. 

7.	 Using the arrow keys, create a dotted frame for the component. 

					   

8.	 Set the grid to 1 dot, and shrink the component frame vertically and horizontally 
by 1 dot. 

9.	 Press the DISP/ENTER key.
The Digital component is displayed. 

					   

10.	Place the cursor on the Digital component, then press the Copy soft key. 

11.	With the arrow keys, move the cursor to the position where you want to paste the 
component. 
If you change the grid interval to 10 dots, you can move the cursor more quickly. 

12.	Press the Paste soft key. 
The component is copied. 

				  

13.	Repeat steps 11 and 12 to make another copy. 

14.	Repeat steps 4 through 13 to create a Bar, Group name, and Tag comment 
component. 

Appendix 1  Example of Creating a Custom Display
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15.	Repeat steps 4 through 9 to create a Trend and Scale component. 
The component IDs are as follows. 

Component ID Component Kind
0, 1, 2 Digital
3, 4, 5 Bar
6, 7, 8 Group name
9, 10, 11 Tag comment
84 Trend
88 Scale

16.	Move and resize each component so that they do not overlap each other.

Appendix 1  Example of Creating a Custom Display
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Changing Component Attributes
Procedure

1.	 Place the cursor over the component whose attributes you wish to change. 

2.	 Press the PROPERTY soft key.
The component attribute dialog box is displayed. 

		  Attribute dialog box example

					   

3.	 Change the settings. Settings not listed below should be left at their default 
values. 

	 Example of component kinds and setting changes

Component Kind Component ID Setting Item to Change New Setting
Group name 6 Background color Lime

Frame Raised
Group name 7 Background color Lime

Frame Sunken
Group name 8 Background color Lime

Frame Sunken
Tag comment 9 Channel number 1

Background color Red
Frame White

Tag comment 10 Channel number 2
Background color Red
Frame Sunken

Tag comment 11 Channel number 3
Background color Red
Frame White

Trend 84 Direction Horizontal
Margin On

Scale 88 Trend direction Horizontal
Indicator Mark
Indicator type Balanced
Margin On

		  Screen creation example (builder screen) and component ID

 0

 1

 2

 3

 4

 5

 6

 7

 8

 9

 10

 11

 88 84

Note
If you set the status area display to Off, you can increase the screen area. 

Appendix 1  Example of Creating a Custom Display
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Setting group control
After setting display groups, set up group control for the custom display. 

Procedure
1.	 Press the MENU key (to Setting mode) and select [Set menu] tab > [Group  

tripline] > [Group]. 

					   

2.	 Set the first and last batch group to 1, then enter the group numbers and channel 
settings as follows. 

		  Display group setting example

Group No. Group name (leave default) Channels
1 BATCH1-1 001, 002, 003
2 BATCH1-2 004, 005, 006
3 BATCH1-3 007, 008, 009
4 BATCH1-4 010, 011, 012

3.	 Return to the custom display builder screen, then press the GR. CTRL soft key. 

4.	 Press the GrpCtrl 1 soft key.
The setting screen for GrpCtrl 1 appears. 

					     		

5.	 Enter the following settings.

	 In the ID boxes, you can only set components for channel assignment (see “ID 
Number of Components” in section 1.4). 

Group Number  
(the group number in step 2)

Order ID

1 1 0, 3, 9
2 1, 4, 10
3 2, 5, 11

Appendix 1  Example of Creating a Custom Display
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Explanation
Channel 001 is assigned to component ID 0 and 3, channel 002 is assigned to ID 1 and 4, 
and channel 003 is assigned to ID 2 and 5. 
Pressing the right arrow key in the execution panel repeatedly changes the display 
group number to 2, 3, 4, 1, 2, and so on. If you press the left arrow key, the display group 
number changes in the reverse order. 
If you press the right arrow key once, channel 4 is assigned to component ID 0 and 3, 
channel 005 is assigned to ID 1 and 4, and channel 006 is assigned to component ID 2 
and 5. 
The switching of the display by setting the display group in step 5 is described in the 
table below (the channel display changes from top to bottom.)

Switching of the channel display when pressing the right arrow key
Component ID: 
0, 3, 9

Component 
ID: 1, 4, 10

Component 
ID: 2, 5, 11

When the display group is 1 001 002 003
004 005 006
007 008 009
010 011 012

When the display group is 2 004 005 006
007 008 009
010 011 012
001 002 003

When the display group is 3 007 008 009
010 011 012
001 002 003
004 005 006

When the display group is 4 010 011 012
001 002 003
004 005 006
007 008 009

Example of switch of screen display

Left and right 
arrow keys

Left and right 
arrow keys

Left and right arrow keysLeft and right arrow keys

Group control 1 to 4 can be set. Use this for the 4-screen display on the DX2000.

Appendix 1  Example of Creating a Custom Display
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Preparing bitmap files
Bitmap files can be assigned to scale and bitmap components. 
The following restrictions apply to bitmap files that can appear in custom displays. 
•	 Uncompressed format with 256 colors or fewer 
•	 Data of screen size 640 (W) x 480 (H) pixels or less

If an uncompressed bitmap file cannot be displayed in a custom display, open the file 
in a Windows-based image editor (such as Windows “Paint”), perform the following 
operations, then save the file. 
Starting Windows Paint

		

1.	 On the menu bar, click Image > Attribute. 
The [Attribute] dialog box appears. 

					   

2.	 Set the width and height to 640 and 480 or less. 
The bitmap file’s size units of pixels will be units of dots on the DX recorder screen.
Starting from the upper left apex as the origin, the bitmap file is cropped to the specified 
size. 

3.	 Set the color as desired, then click [OK]. 

4.	 On the menu bar, click File > Save As. 
The [Save As] dialog box opens.

					   

5.	 Enter a file name, then set the file type to [Monochrome bitmap], [16 color bitmap], 
or [256 color bitmap]. 

6.	 Click the [Save] button. 
The bitmap file is saved. 

Appendix 1  Example of Creating a Custom Display
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Assigning bitmap files to components
Display the attribute settings for the component to which you want to assign a bitmap. 
Check the bitmap source directory, then save your bitmap files to that directory. 

Procedure
1.	 Move the cursor onto the scale component.

2.	 Press the PROPERTY soft key.
The component attribute dialog box is displayed. 

3.	 Set the [Kind] to [Bitmap].

					   

4.	 Click the [Details] button, then press the right arrow key. 

5.	 Select a directory, then press the DISP/ENTER key. 
The directory is displayed. 

					   

6.	 Press the DISP/ENTER key.
The directory display screen closes. 

7.	 Perform the following operation to save the bitmap file to the directory on the CF 
card you checked in step 4. 
1.	 Press the FUNC key, then press the soft key to eject the media. 
2.	 Press the CF soft key.
3.	 Remove the CF card. 
4.	 After saving the bitmap files to the CF card, insert it into the DX recorder. 

8.	 Enter the bmp file name. 

					   

Appendix 1  Example of Creating a Custom Display
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9.	 Click [OK], then press the DISP/ENTER key. 
The bitmap is displayed in the scale component. 

Explanation
The directory for saving bitmap files is the directory last used for loading data.
You should make the size of the components displaying bitmaps the same size as the 
bitmaps themselves. If the bitmap is larger than the component, it will be cropped by the 
size of the component. 

Appendix 1  Example of Creating a Custom Display
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Appendix 2	 Viewing Screens Created in DAQStudio

This is an example of how to view a screen created in DAQStudio on a DX recorder. 

Procedure
When receiving screen data from the DX recorder, the Channel/alarm list page is 
displayed in the work area. 
If the DX includes the /AS1 option, set up the DX in advance as follows. (In the example 
of setting up the DX below, the user ID is not set.)
DX main unit (with /AS1 option) settings

1.	 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to 
basic setting mode), and select the Environment tab > Security > Communication, 
and set Login. 

2.	 Select the Menu tab > User registration > Admin settings > Mode, set [Key+Comm], 
enter the user name, and return to the operation screen.
If a password is set, this concludes the setup. If no password set, perform the following 
additional steps. 

3.	 Press FUNC, select Admin1, then press DISP/ENTER. 

4.	 Skip the user ID and select ENT. 

5.	 Enter Admin1 for the password, then select ENT. 

6.	 Enter a new password (between 6 and 20 alphanumeric characters, no spaces 
allowed), then select ENT. 

7.	 Reenter the new password and select ENT.

Operation of DAQStudio
1.	 Open data that was created and saved in DAQStudio. When you open such data, 

if there are components to which bitmaps are assigned, be sure you save the 
bitmap files in the same location as the screen data. 

2.	 On the menu bar, click Communication > Send.
The send dialog box appears. 

					   

3.	 Check that the screen version and DX recorder version match. 

	 If the DX recorder version is earlier than the DAQStudio screen version, some 
components may not display. 

4.	 Enter the IP address and host name, and the user name, user ID, and password 
set on the DX recorder.  

	 If a user name is not set on the DX recorder you are sending to, enter [admin]. 

5.	 Click the [Send] button. 
The screen sent to the DX recorder is displayed. 
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Appendix 2  Viewing Screens Created in DAQStudio

Explanation
DAQStudio screen versions and the DX recorder firmware version
When sending and receiving screen data, make sure the DAQStudio’s screen version 
and the DX recorder’s firmware version are either the same, or the version on the 
receiving end is newer. If the versions differ and you attempt to display screen data 
created on a new version using an older version, the components may not display 
properly. There are more kinds of components that can be created and attributes that can 
be set on the newer version. Since these cannot be displayed on the older version, the 
display will be incorrect. 

Sending and receiving data to and from DAQStudio
When sending data from DAQStudio to the DX recorder, all screen and bitmap data 
in the folder containing the data being displayed by DAQStudio is loaded on the DX 
recorder. 
When DAQStudio receives data from the DX recorder, all screen and bitmap data in the 
folder containing the data being displayed on the DX recorder is received into the folder 
containing the screen data currently being displayed by DAQStudio. 
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Appendix 3	 Differences in Components by Release 
Number

The component types and attributes that can be created for custom display screens differ 
depending on the DX recorder release number. 
Hereinafter, release number 3 will be notated as R3. Release number 4 will be notated 
as R4 if the firmware version is earlier than 4.11, and "R4(4.11)" if the firmware version is 
4.11. 

When displaying R3 screen data under R4 or R4(4.11)
•	 Component attributes that became available for setting in R4 are set to their defaults.
•	 [2nd span Lower] and [2nd span Upper] settings of trend and scale components can 

now be set up to 1 decimal place.
•	 When displayed under R4(4.11), the batch name component display is updated every 

second.
When displaying R4 screen data under R4(4.11)
•	 Component attributes that became available for setting in R4(4.11) are set to their 

defaults.
•	 Batch name component displays are updated every second.

When displaying R4 or R4(4.11) screen data under R3
•	 Components not supported in R3 are not displayed.
•	 The [Depend ID]’s of components dependent on other components that are not 

supported in R3 are set to [None].
•	 Component attributes not supported in R3 are deleted. The [Vertical display] of 

components whose attributes are deleted (Labels, Tag no., Tag comment, Units, 
SpanL, and SpanU) is changed to [Horizontal display].

•	 Component attributes not supported in R3 are ignored. The method of plotting is 
changed for components whose attributes are deleted (trend and scale).

•	 For the trend component’s [2nd span Lower] and [2nd span Upper] attributes, the 
number of decimal places is changed to 0, and the number after the decimal point is 
rounded.

•	 For the scale component’s [2nd span Lower] and [2nd span Upper] attributes, the 
number of decimal places is changed to 0, and the number after the decimal point is 
rounded.

•	 If not displaying the status area in an R4 screen, it is displayed. Components in the 
status area are repositioned.

	 From the point at which you move the cursor to move a component, components in 
the status area move below the status area. When the status area is set to No Display, 
the height of components whose height is at the maximum remains the same, and the 
component is displayed below the status area.

•	 When displaying R4(4.11) screen data under R3, the batch name component display 
is not updated.

When displaying R4(4.11) screen data under R4
•	 Component attributes not supported in R4 are ignored. The method of plotting is 

changed for components whose attributes are deleted (batch name, communication 
input, and Modbus in).

•	 Batch name component displays are not updated.
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Differences in Components by Release Number
Component R3 screen R4 screen R4 (4.11) screen
System icon New Same as R4.
Group name New Same as R4.
Batch group number New Same as R4.
Batch name New Same as R4.
Time label  New Same as R4.
Memory bar New Same as R4.
Modbus In New Same as R4.

Differences in Attributes by Release Number
Component Attribute R3 screen R4 screen R4 (4.11) screen
Screen Status area New Same as R4.
Labels Vertical display New Same as R4.
Tag No. Vertical display New Same as R4.
Tag comment Vertical display New Same as R4.
Unit Vertical display  New Same as R4.
SpanL Vertical display New Same as R4.
SpanU Vertical display New Same as R4.
Bitmap Trend grid mode New Same as R4.
Line Trend grid mode New Same as R4.
Trend Margin New Same as R4.

Change group New Same as R4.
Time interval New Same as R4.
Time grid display New Same as R4.
Scale grid display New Same as R4.
2nd span     Lower No decimal 

place setting
One decimal 
place can be 
set

Same as R4.

2nd span     Upper No decimal 
place setting

One decimal 
place can be 
set

Same as R4.

Scale Indicator type New Same as R4.
Unit New Same as R4.
Margin on both sides 
of Span

New Same as R4.

Display group 
switching

New Same as R4.

2nd span     Lower No decimal 
place setting

One decimal 
place can be 
set

Same as R4.

2nd span     Upper No decimal 
place setting

One decimal 
place can be 
set

Same as R4.

Batch name BG transparent NA New
Communication 
input

Decimal place New

Modbus in Decimal place NA New

Differences in Actions by Release Number
Component Function R3 screen R4 screen R4 (4.11) screen
Batch name Update cycle NA Not updated. 1 sec

Appendix 3  Differences in Components by Release Number
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grid.......................................................................................... 1-6
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